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Preface

Scope and Audience of this Manual

This manual is infended for operators in charge of monitoring and managing Bull servers
with Bull System Manager, in particular via the Bull System Manager Console. It comprises
the following chapters:

Chapter 1

Chapter 2

Chapter 3
Chapter 4

Chapter 5

Highlighting

About Bull System Manager
presents Bull System Manager architecture and components.

Getting Started

explains how to use Bull System Manager to perform basic monitoring
and management tasks.

Using Bull System Manager Console

describes Bull System Manager Console functionalities and use.

Using Bull System Manager Console Applications

describes Bull System Manager Console applications and use.
Categories and Services Reference List

describes Bull System Manager monitored categories and default
services, according to operating system and hardware

The following highlighting conventions are used in this manual:

Bold Identifies commands, keywords, files, structures, directories, and other
items predefined by the system. Also identifies graphical resources such
as buttons, labels and icons that the user selects.

Italics Identifies chapters, sections, paragraphs and book names to which the
reader must refer for more information.

Monospace Identifies examples of specific data values, examples of text similar to
what you might see displayed, messages from the system, or
information you should actually type.

Note Important information

Related Publications

For more information about Bull System Manager, please refer to:
e Bull System Manager Installation Guide (Ref. 86 A2 54FA)
e Bull System Manager Administrator’s Guide (Ref. 86 A2 56FA)

e Bull System Manager Remote Hardware Management CLI Reference Manual

(Ref. 86 A2 58FA)

e Bull System Manager Server Add-ons Installation and Administrator’s Guide
(Ref. 86 A2 59FA)
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e Restrictions and well-known problems are described in the associated Release Notes

document (Ref. 86 A2 57FA).

e For information about the Open Source products used by Bull System Manager, please
refer to:
www.nagios.org (for Nagios product)

www.webmin.com (for Webmin product)

www.mrtg.hdl.com (for MRTG product)
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www.nagios.org
www.webmin.com
www.mrtg.hdl.com

Chapter 1. About Bull System Manager

1.1 Scope

Bull System Manager is the graphical interface tool used to manage Bull servers. It provides
two main functions:

Supervision (monitoring, reporting, information)

Supervises system resources.

Detects anomalies and notifies them to defined entities. It also provides the interface that
displays all important information.

Administration (remote control)

Used to configure target hosts and to execute actions on these hosts via the OS or via a
Hardware Management tool.

80 Fie Views Tools Notification

: eggcu:num \ - Inventory
T Reporting | R e N —

= M nsmaster

E-mail, SNMP, trap

-1 Bull Maintenance Status | | e —
(B Lirasanics, | —— . ] —| Alerts
[= . . === e~ Ll yaaa
& o
a:ﬁnm“ﬂ/’Momtorm-Fm;_ - Trends

¢ Sslernload

& spplicaien
[ securiy

3 vstem
% ¢ Logicsi0iE
= ﬁSg'slemLusd

@ cru
@wmy  Remote OS Contr

= ¢ windowsSenices

Remote Hardware Management

" VNC, telnet ...

E— S\

ARMC, ESMPRO,

Figure 1-1  Overview of Bull System Manager functions
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1.1.1

2

Two Bull System Manager user roles are pre-defined:

Operator Role:
An operator can read host and operating system information, but has no access to the
administration tools.

Administrator Role:
An administrator can perform administration, configuration, update, and remote
control tasks on target hosts.

Supervision Features

Host Monitoring:
Checks if the target host is accessible (via the ping command).

Monitoring Services:

Monitors OS CPU load, memory usage, disk usage, number of users, processes and
services execution, http and ftp services.

Thresholds are used to assign a state (ok, warning, critical, unknown) to hosts and to
each monitored element.

Alerts (in a log file) and notifications (by email) are generated when anomalies occur
or when normal states are recovered (return to ok state).

Monitoring Services are classified into Monitoring Categories: Systemload,
Filesystems, Eventlog...

Hardware Monitoring:

—  NovaScale servers get hardware health status via a call to CMM, ISM and PAM
Hardware Managers or via an IPMI OutOfBand access.

—  Express 5800 servers get power status via a call to the RMC Management Card.

Selectable View Displays:
Presentation of hosts and monitoring services through different views. A view is a tree
structure that can display:
— the entire list of hosts,

-~ managers and the hosts they manage,

—  host groups.

From each tree node, the user can display detailed information about a host or a
service, according to user roles (Administrator or Operator).

Group Definitions:

Host groups and Group groups can be defined to organize server infrastructure as a
tree.

Alerts:

Notifications of problems via email, SNMP traps or Bull format autocalls.

Selectable Map Displays:

Presentation of hostgroups (with the status of their hosts and monitoring services)
through different maps.

BSM 1.0 - User's Guide



A map is a layout, in general with a background image, which displays associated
hostgroups. Hostgroups are located at specified positions (x,y) on the map and are
animated with the status of associated hosts and monitoring services.

From a hostgroup, the user can display detailed information about all associated hosts.

1.1.2 Administration Features

Eventhandling mechanism based on status changes.

Webmin Management Tool for Linux hosts:

Webmin is an Open Source product that gives OS information (about users,
filesystems...) or executes OS commands, in a graphical environment, locally on Linux
target hosts.

Remote Operation Tools:

- telnet to access Linux and Windows hosts.

- Rdesktop or UltraVNC to access Windows hosts. UltraVNC is an Open Source
product that allows you to take control of remote hosts as if you were in the
remote host Windows environment.

Hardware Manager Calls:

- PAM for NovaScale 5000 and 6000 Series platforms.

- CMM for NovaScale and Evolutiveline Blade Series Chassis platforms.

- ExpressScope or SIMSO+ for NS T800 and NS R400 servers

—  ARMC for Express 5800 servers.

Targeted systems can be powered on / off via these managers and Bull System
Manager provides a single Hardware Management GUI for basic tasks.

Virtualization Manager Calls:

- ESX WEB GUI for VMware ESX platforms.

—  HN Master for Xen platforms.

- IVM for VIOS platforms.

Storage Manager Calls:

Embedded Storage Manager GUI that are integrated in the Storage bays.

Chapter 1. About Bull System Manager 3



1.2

1.2.1

1.2.2

1.2.3

4

Basic Definitions

Service

A service is a monitoring check, which supervises a monitored item. Monitoring agents
compute service status (OK, Warning, Critical, Unknown or Pending) and status
information (a text giving more information on the service state) for each service.

Example:
The CPU service, which returns a status about CPU utilization, displays the following
information on Windows:

CPU Load OK (1mn: 8%) (10mn: 5%)

Category

A category is a container for a group of services.

Example:
The Systemload category for Windows systems contains both CPU and Memory services.

View

A view is how monitored hosts are displayed on the screen. Views differ in structure, but
they all display hosts with an animation reflecting service status (ok, warning, critical, or
unknown) and associated monitoring services, classified into categories, under the host
node.

The advantage of views is to display only what the user wants to see at a given time. For
example, if a user is interested in Hosts and not in Managers or Hostgroups, he can
display the Hosts view.

As Administrator, you can create customized views for hosts and groups. Refer to the
Administrator’s Guide for details.

Notes

e According to configuration, a category may or may not be present. For details, refer to
the Administrator’s Guide.

e Each type of node in a view has specific menus detailed later in this manual.
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1.2.4 Map

A map can be used to display the status of a selection of hostgroups (with their monitored
hosts) on the screen.

In general, the map has a background image and hostgroups are located at specified
positions (x,y) on the map. Maps differ in appearance, but they all display hostgroups with
an animation reflecting service status computed from the status of the associated hosts and

monitoring services.

When you zoom in on a hostgroup, you can view associated hosts and overall service
status (the worst status of the associated monitoring services).

The advantage of maps is to display only what the user wants to see for a given context.

As Administrator, you can create customized maps for hostgroups in different contexts.
Refer to the Administrator’s Guide for details.
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Bull System Manager Components

Bull System Manager is based on a 3-ier architecture:

Monitoring Console

This WEB-based application running in a browser (Internet Explorer or Mozilla)
accesses collected monitoring data using WEB technology.

Monitoring Server

Collects, processes and stores monitoring and reporting data. It runs on both Windows
and Linux platforms.

Monitoring Agent

Contains the basic programs used to obtain monitoring and inventory information. It is
installed on each target system.

Bull System Manager comprises Open Source software:

Nagios

For the monitoring function.

MRTG

For the reporting indicators function.
Webmin

A Linux administration tool (a standard Webmin package and a Bull System Manager
Webmin restricted to obtaining information).

UltraVNC Server
For remote operation on Windows hosts.

IPMltool

For remote operation on hardware systems that contain the Intel BMC (Baseboard
Management Controller).

Bull System Manager also comprises an optional component for scripting applications on
Linux platforms:

Hardware Commands
A Command Line Interface (CLI) for remote hardware management, providing an easy
interface for automating scripts to power on/off or get the power status of a system.

These commands can only be used on Express 5800, NovaScale R400 & T800 series
or NovaScale 4000, 5000 and 6000 series servers with a Linux Operating System.
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1.4  Bull System Manager and Security

Bull System Manager security is based on a combination of secured applications using
authentication and profiling (role based) mechanisms.

1.4.1 Avuthentication

Each Bull System Manager application uses a user/password or single password
authentication mechanism for access. Users are defined on the Bull System Manager
server.

1.4.2 Role-based Management

Each Bull System Manager Console user is associated to a role (or set of functionalities).
There are two types of profiled users:

Operator

An operator can read host and operating system information, but has no access to the
administration tools.

Administrator

An administrator can perform administration, configuration, update, and remote
control tasks on target hosts.

Chapter 1. About Bull System Manager 7
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Chapter 2. Getting Started

This chapter explains how to use Bull System Manager for basic monitoring and
administration tasks.

2.1 Starting the Console

See Chapter 6 of the Installation Guide for details on how to launch the console and

applications.

2.1.1 Console Basics

Title Bar

Supervision Area Administration Tools

S =TET)

Sycte: [l tanager 103 - Console - Micrasolt Tntermat Explorer
MEEE

n BEM Caonsole —_

H & Tree ‘Welcome tn Eull Sy=iem Kanager
Supervision [| &0 V
Mode & Alorts SRMURT coda
Laogin Arrniniglrabor
ESH Toals Hoie Agrninisirator

A |
BSM Tools []| [<]

Bull Tools:
&

Bull Tools | |

Other Tools 1

& [ 8 Locel infraret =

Figure 2-1  Bull System Manager console
The Bull System Manager console is divided into the following functional parts:
Title Bar displays the server name.

Administration Tools enables access to the administration tools:
Bull System Manager configuration application,
Bull System Manager documentation,
Bull System Manager download page.
Displays server information: Netname, Date/Time, Login and Role.
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Supervision Mode allows you to choose one of the three modes of supervision:
supervision through a tree,
supervision through a map,
supervision through alerts.

Supervision Area displays information about the monitored resources, related to the type
of supervision (see Supervision Information, on page 51).

BSM Tools enables access to the Bull System Manager Tools:
Reports, Hardware Management.

Bull Tools enables access to the Bull Applications:
Bull Support, Cassatt Controller, Cassatt Manager, BPRSE, BPREE, ARF.

Other Tools enables access to external applications.

Bull System Manager Authentication and Roles

Bull System Manager applications must be authenticated. They use common Bull System
Manager users defined on the server part.

Authentication type varies according to the Bull System Manager Server operating system
(Linux or Windows) and to the WEB Server (Apache or Microsoft IIS) (see next
paragraphs).

Note  In order to change the current authentication for Bull System Manager. You MUST close all
the opened WEB browser windows and relaunch a new session of this browser. Else, the
browser will keep the previous authentication context.

Role Based Management
The authenticated user is used to apply a user profile or role. Two default roles have been
defined for Bull System Manager:
Operator with access only to supervision information.
Administrator with access to supervision information, configuration tasks and Remote
Control functions.
Applications Role Functions
Monitoring and Reporting Operator Information access
Administrator + server control access
Remote Control OS Operator None
Administrator Remote Control access
Hardware & Storage managers | Operator Information access
Administrator + Remote Control access
Table 2-1. Roles and Functions
Note User roles can be only configured by a user with Administrator role. For further details,

refer to the Administrator’s Guide.
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Bull System Manager Server User Authentication - Linux

Apache server authentication

A default Apache user called bsmadm (password bsmadm) is created when Bull System
Manager Server is installed. This user is not a Linux user and will only be used contextually
by this WEB Server.

Connect to 172.31.50.90
‘f?

YL
1 .If '}:\‘
gl

Bull Svstem Manager Configuration Authentication Access

User narne: I ﬂ bsmadm j

Password: | sessns

[ Remember my password

K I Zancel

Figure 2-2  bsmadm user authentication — Linux

The users database is stored in the following file:
/usr/local/bull/SystemManagement/core/etc/htpasswd.users

Adding a New User / Modifying a Password
To add a new user or to modify a password on the Apache server:

1. Log on as root and launch the following command followed by the required user
name:

# htpasswd /usr/local/bull/SystemManagement/core/etc/htpasswd.users <USERNAME>

where <USERNAME> is the user name you want to add or modify.

2. Enter the new password: *****

3. Retype the new password: *****

Adding password for user <USERNAME>

Chapter 2. Getting Started 11
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Bull System Manager User Authentication - Windows
Authenticated users are users declared in the Windows users database.

Using Internet Services Information WEB Server

The user can be a local user or a domain user. The domain must be specified for domain

users (e.g DOMAIN\User).

Bull Svstem Manager Configuration Authentication Access

User name: I € Administrator j

Password: | sessns

[ Remember my password

K, I Cancel

Figure 2-3  User authentication with IIS WEB Server - Windows

Using Apache WEB Server

Any user in the Windows user database of the server, or any trusted domain to which the

server belongs, will be granted access.
The user name must be entered in the following format: DOMAINNAME\Username, even

for local users. The domain name must be fully qualified.

Connect ko 172.31.50.90

Bull 3vstem Manager Configuration Authentication Access

Lser narme: Iﬁ Frls31 . Fril bull. Fridministr akar j

Password: I sessns

[T Remember my password

I I Zancel

Figure 2-4  User authentication with Apache WEB Server - Windows

This chapter continues with the description of what you can do with the console.
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2.2

2.2.1

Displaying Monitoring Information

Starting with the Tree mode

Notes

e Tree Mode concepts are explained in detail in Chapter 3.

e When the Console is started, the default view is opened, i.e. the Hosts view,

displaying all the declared hosts at the same level.
By clicking in the File menu, you can load three other views: the Hostgroups view, the
HardwareManager view or the StorageManager view.

As Administrator, you can change the default view. Advanced users can create
customized views. Refer to the Administrator’s Guide for details.

The left part of the console is a tree representing all the managed platforms. It can be

expanded as shown below:

File “iews Tools

(s} Hosts | Level 0: Root |
- ARMC
=-J&ll nsmaster —————[ Level 1 Host |

EI@ EventLog

----- i) Application

D Security

.-:, Systam

[—ZI---@ Hardware

Q Alerts

IEI@ Internet

['—Zlu;f*:b LogicalDisks

8

=&Y SystermnLoad

.::. CPU

3 Memary

=G WindowsServices
- EventLog

-l NSMASTEROLD

Level 2: Category

Level 3: Monitored Service

Figure 2-5 Example of expanded Hosts tree

A Service is a Monitored Entity and the color of the icon reflects service status:
red (critical), orange (warning), magenta (unknown) or green (ok).

Each icon is divided into two sections:

Chapter 2. Getting Started
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The top left is reserved for the animation for itself and the bottom right is reserved to
cascade animation from its subtrees.

For instance for a Host node: when there is a service status change, the color of the bottom
right corner of the category icon changes to reflect this change.

The color of the top left corner of a host icon indicates if this host is alive or not (result of a
ping command).

Example:
The top left corner of the nsmaster host node is green because it is alive and the bottom
right corner is green because all its services are ok.

A Category is a node grouping monitored services logically. Category status reflects the
worst status of its associated services.

Looking in the Past

When a problem occurs, it is interesting to know if it already occurred in the past, and how
many times it occurred.
Bull System Manager offers many ways to analyze what occurred in the past.

Looking in the Past with Alert History

From the Applications pane, click Reporting > Alert History. The following display appears
(in this example, the host is called FRCLS8004).

File ‘iews Tools Q8 2 p iEI &
L]
@ Map m Hosts ) SERVICE: EventLog.Application on FRCLS8004
@ Alerts Eﬂ AL_HVA : Reporting
. | Alert History | Motifications | Availability | Status Trends | Indicators Trends |
B¢ AlGEnices =
=M FileBystems -
@ v E\E_Z[I""ALL HOSTREROUFS ™ ,I Alatts type Hosts and Services -I ™ Mot adknowledged
- Al - .
BSM Tools = & [Freise o] Aetstevel Al W History
F-G Hardware Report Peried | Last 24 Hours -1
D E‘§ Syslog hax ltems: 16 Apply I Heset I
) Errors
@ &Gl SystemLoad Last Updated: 13-10-2008 14:52:43
' a: pdated: -10-. R
=B FreLss004 Matching Alerts Updated even 120 secands
B¢ EventlLog Time Host Senice State Count Information
O Application 13-10-2008 14:52:24  FRCLE8004  Eventlog Application oK 1 OK: no new events for the last 10 mn
Other g rits for the last 10 mrl
A ) Security \SA TR e e T 3 | R W Tl
13-10-200814:17:34  FRCLS8004  Eventlog Application 1 most significant are:
_._.:‘ ) gystem Warn - 6 ID O from snmptrapd
ek - LogicalDisks 1310-200811:17:44  FRCLSB004  Eventl og Application oK 1 OK: nonew events for the last 10 mn
5) SystermnlLoad 3 new everts for the last 10 mnl
6) WindowsServices 13-10-2003 11:07:44 FRCLS3004  Eventlog Apolication 1 mast significant are:
Warn - 3 1D O from snmptrapd
&l NeTaz0 R
13-10-2008 10:37:54  FRCLSS004  Eventlog Application ok 1 OK: no new events for the last 10 mn
[+-Q¥ Eventl
B @ vent-og 4 new events for the last 10 mn!
- @ Harthware 13-10-2008 10:27:54 FRCLSS004  Eventlog.Application 1 most significant are:
B¢ LogicalDisks Yarn - 4 1D O from snmptrapd
-10- icati 0K
@ SysternLoad 153-10-2005 10:02:54  FRCLSA004  Eventl og Application 1 OK: no newr events for the last 10 mn
" : 1 new everts for the last 10 mnl
& 1 new everts for the last 10 mnl
= @ WindovwsBervices 13-10-2008 09:42:54  FRCLZ3004  Eventl oo Application 1 most significant are: -
Warn - 1 1D 0 from snmptrapd
12-10-200817:59:34 FRCLSS004  Eventlog Application ok 1 OK: no new events for the last 10 mn
3 new everts for the last 10 mnl LI
[&] ’_ ’_ ’_ [ Local inkranet &

Figure 2-6  Alert History window
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The history shows all the alerts that occurred for this service, in periods of time. Service
information is also logged, providing all the information required to decide if a corrective
action is needed.

Looking in the Past with Status Trends Information

The Alerts and Trends functions use monitoring logs to display past information:
e Alerts shows events.
e Trends shows a status graph for a given period of time.

In the example shown in Figure 2-6. the monitored system is FRCLS8004. The tree shows a
WARNING state on Eventlog.Application. Click Application to display status information.

= |
HEBRAE
File Wiews Tools el B R el he
i Tree !
& Map 1l Hosts ) SERVICE: FventLog.Application on FRCLSANDH
& Alerts 3 nm Hiva Klanfnring
- | Senvice Slatus || Cordol
B s 2681
- B PROLSE004 Service detail List Usdutuc: 1410:2008 15.18:21
= £ Everilog
ESHd Toals ‘Serace Status: Larsd Check Duratine Iinfoe rmation
12 Mpplicadion i A0
EwiiL M.hl‘l Ol Oy 1rm 2558 Ot Oy B 2554 el Iti*“
|:| | [ sy it ; b Ve - 210 4rom srergtragd
- Eystem
@ * ﬂ LogicalDisks
| ¥ O Svaternbosd
= G windows Senices
= -. nsrnashar
m"ﬂ. + Bl narezo
v
2] Apcht appetcommand started [ S Locel infraret =

Figure 2-7  Status Information for Eventlog.Application service

If you want to know if this situation often occurs, and when it occurs, click Reporting >
Status Trends. The following display appears:
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File Wiews Tools

2004 rclbulllr - Bull Sysbem Mansger 102

e e e n | i

- Console - Microsolt Inbesnet Explarcr

15k Hosts

=il 2 _Hva

- B e ks 2t

L [ER =TT

= £ Ewerilog
2 Apgcation
B sty
B svstem

s ﬂLﬂni:alDlsks

=3 Svaternlosd

G windowsSenices

o= . nsmashar

= Bl nstezn

| Opesaling Syslem=|

=
Fapart Perict | Lazt 24 Howrr = hﬂbl
Fromm 13003003 151421 o 18405008 1594:21 {duralion 14 0h 0 O3
Chronalogy
i - S - SO |
o 8 ]
Urs i _'-J:E 4 -
Crizica : i ?1 E-
TeUTIEND 11§ TREEE
HegEes 3 E g ¢ 54
4 n@nby @ Z aE oo ]
9 28533 H8 = x5 3 -
AR89 4914 I In 3 IE
3 HEEEER I E B & 3E
§ 55555 B3 b} - g3
Aoailability
% Time 0K % Time: Warnding % Time Linknossn % Time CrEical % Tims: Incetareninata
EEE 000 0.0 0.00%
| | |.|

2 SERVICE: FventLog.Application on FRCLSAN04
T ks e

2]

[ Modbiret s

Figure 2-8  Status Trends for Eventlog.Application service (last 24 hours) - example

The graph of the situation for the last 24 hours shows that BSM has detected some recent
Eventlog.Application warning.

Viewing More Information

The Applications pane is used to display information requested by menu items or links.

e Click a node in the Tree pane to display basic monitoring information, according to

node type.

e Rightclick a node in the Tree pane to display a popup menu giving access to all
operations available for that node.

e Click an option in the double level menu in the Applications pane to access to all
information available for that node.

Example:

When you click the FRCLS8004 node, the following display appears, indicating that the

status for this host is UP:
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File Views Tools

@
(Ml Hosts 2 HOST: FRCLSBO04 i
@ Ak & ™ Monitosing
-.l.lbg_ Hust Status | Senice Status || Contral
= AldSenices
=1 ¢l FileSystems Host detail Last Undatad: 13102008 46:17:12
1 L Host Status LasliCheck  Duration Information
o @l Hardware FRCLSB004 - 0dOhim18sago 3d0nS2m 24z PRl - Packel loss = 0%, RTA =
=} (ﬂ Syslog
. Etrars
% &l SystemLoad o
;ﬂ e Applicative double
=& FRCLSB004 .
-8 level menu:
=) ieang information on the
Application
syster
. Security
B system
=-¢ LogicalDisks
% G Systemload
cd} qﬂ WindowsSerdces
=8l nsTs20
v
& =

Figure 29  Host status display - example

From the Applications pane, click Hardware Information > Inventory to display the host
hardware inventory.

File Wiews Tools
@ Map (8l Hosts 2 HOST: FRCLSS004 i
@ Alerts [l nc_Hvd : Inventory
: Platform ~ | Operating System - |
| EG ASenices -
= Gl FileSystems Computer Information
il Harme - FROLSA004
& Hardware Duirein - VIORKGRIOLP
=& Srslog Modsl : FOVVERMATE MLA50
W Enore Maresfacturer : REC COMPUTERS SAS
i Pryszical Memory @ 101 5 Mbrytes
@ ¢ SystemLoad
i Bios Information
=S FrReLsBo04
! a EveniLog fleme : BI0S Dk 1103006 13:45:17 Yer: 0E3
. Manuiaciurer - American Megstrends Inc.
~ I Application Versian ; & M1-11000609 |
-0 security Serial Mumber - 207560600002
13 aystem Version, ss reported by SMBIDS ; 00013
| =P LogicalDisks Processors Information
=& SystemLoad (5] Hame Clock Spesd Address Width Load over the Last Minute Stetus
=G Windows Semices CPLU
| CPUD Inel(f) Penbum(R) D CFU 2 S0GHZ 2793 MHZ 32 bes 2%
=8l naTazo Enabled
(%) (ﬂ Ewvenilog CPU
E Ea Hardware CPLH  IntelR) Pentium(R) O CPU 220GHz 2783 MHz 32 bitz 0% Enabled
=¥ LogicalDisks . ;
Physical Memory Information
=-¢3¥ SystemLoad
ﬁ,a \WindowsSenices Installed Banks in Memary Areay 1) max capecity 4.0 Ghytes
Bank Mo Bank Label installad Size Memory Form Memary Type 1I
[&] pone [ [N Local intranet s

Figure 2-10 Host information - example
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2.3 Receiving Alerts

As Administrator, once you have built your configuration, you can set up email and/or
snmp notifications for enhanced operational monitoring

2.3.1 Sending Email Notifications

To configure the email notification mechanism, proceed as follows:
Step 1: Start Bull System Manager Configuration.

Step 2: Configure the Mail Server (only if Bull System Manager Server runs on a Windows
system).

Step 3: Specify the mail address of the receiver.
Step 4: Reload the monitoring server to take the modifications into account.

Refer to the Administrator’s Guide for details.

2.3.2 Sending SNMP Traps Notifications

To configure the SNMP notification mechanism, proceed as follows:

Step 1: Start Bull System Manager Configuration.

Step 2: Specify the SNMP managers to which the traps will be sent.

Step 3: Reload the monitoring server to take the modifications into account.

Refer to the Administrator’s Guide for details.

2.3.3 Viewing Notifications

In the following example, an authentication failure has generated an email notification:

***** Bull Bull System Manager *****

Notification Type: PROBLEM

Service: LogicalDisks.All

Host: w2k-addcOl1 Description: Portal DC (current network name: w2k-
addc01)

Address: w2k-addcOl1

State: CRITICAL

Date/Time: Wed May 18 16:26:21 GMTDT 2005

Additional Info:

DISKS CRITICAL: (Z:) more than 95% utilized.

The Bull System Manager Console allows you to view all the notifications sent by the
monitoring server.
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Taking Remote Control of a Host

As Administrator, if you want to investigate a problem and fix it, you need to take a remote

control of the platform concerned. Bull System Manager uses standard, commonly used

tools to perform this function. These tools differ according to whether the remote operating

system is Windows or Linux.

Windows Hosts

UltraVNC Viewer is used to connect remotely to Windows hosts.

Note

Prerequisite: The VNC package delivered with Bull System Manager must be installed and
started on the remote host. Refer to the Installation Guide for details.

Example:

Bull System Manager informs you that the C: disk is nearly full on the nsmaster Windows
host, via the LogicalDisks node, and you decide to connect to nsmaster to see if you can

free some disk space.

To connect to the remote host:

1. Start VNC Viewer from the nsmaster host menu (Operations > Operating System >

VYNC Viewer).
3 httpz/ SfrclsB004 frcl bullfr - Bull System Manager 1.002 - Console - Microsoft Intermet Explorer
] File Wiews Tools aa R nIE =
@ Map  ||( Hosts . HOST:mstmaster i
@ flerts o [l s Hve 181l | Reparting |inventory [ v L r 7
Operating Svstem - |
: - B frels 7681 b VNG Viewar a
@ B FreLsoons WG ation
BSH Tonl E'- Remate Deskion MSMASTER
B &l vsTRz0 Domsain : YWORKGROUP
:| Madel ExpressS5000 2000 [ME100-94 28]
| Marfactrar MEC
@ I| Physical Meimory 1023 Mbytes
:| Biog Information |
I Meeme: : Proent: ServerBIOS 3 Release 610.20442
anuiacdurer : Proent: Technologes Lid
Other Wersion FTLTE: - E040000
L Serial Munber © E00064740087
- | wersion, a3 reporled by SVBIOS ; B.0.20M42
E Processors Information
| I HMame Clock Speed Address Width Load over the Last Minute Stat
i CPUO Infelf) Xeon(Thi) CPU 280GHz 2793 MHz 32 bts 4% £
i CPLH  Ifek)R) Hean(Th) CPU 2 80GHz 2733 MHz 32 bis 0% I
Yo Physical Memory Information &
4 | _bl—l
|@ H:I:p:j'll'Fr:lﬂﬂEI4.frt|.b'l.ﬂ.fr.l'ESI"'ll'mhsalsa'md'n;r-phpiwappw.pb?pund—lmmbuwﬂtﬂsb—rﬁﬂesterﬂqudutw__ — ’_ |lg'l.oca| intranek e
Figure 2-11 Starting UltraVNC Viewer on a host
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2. When prompted, enter the password used when VNC Server was installed or
configured on the target host (nsmaster in the example).

B Tightvnt desktop [nsmaster] - Microsolt Inbernet Explorer =18] x|
||l o wew Favokes Tock e ||Wm“|u:r.rlzs.nfz.o.m:mr cBe | &
x

D 3cc'.rec|| Omml Gllnkioard | Eend Sir-AOg | "erres'.l

VNC Authentication

password: [ oK

al 1 AI:I
Bistert| [ D & Eeees ft | ootiio...| B ucoderesmaterns . | ) Tohowc descp (name.. | g £ Sl PN 1538

Figure 2-12 VNC Authentication window

3. Click OK. You now have full access to the remote host (nsmaster), although response

times may be longer.

Disconnect | Options | Cliphoard | Send Cirl-Alt-Del | Refresh

W2000A5_FR (C:) Propetties 3 _ﬂi‘

Seculy | ShadowCopies | Quota |
General | Toge |  Hodwae | Shaing

¥

Type Lacal Disk.
File spstem:  NTFS

M Usedspace 2964 521 984 bytes
M Fiee space 5425 263 104 bytes

Capacity: B389 785 088 bytes

Diive € Disk Cleanup

I~ Compress diive to save disk spacs

IV &llows Indexing Service to jndex this disk for fast fle searching

[ ok | Cancel £55lp

Figure 2-13 Remote connection to a Windows host with VNC Viewer

You can now display information related to disk C: and perform corrective actions.

Note  If you do not require full access to the remote desktop, you can also open a telnet
connection, if the telnet service is started on the remote host.
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2.4.2 Linux and AIX Hosts

Webmin is used to connect remotely to Linux and AIX hosts.

Note ~ Webmin is a graphical tool for managing Linux and AIX systems and allows you to
configure the system, application servers (http, mail...), the network, and many other
parameters. Webmin is Open Source software and the Open Source Community regularly
adds new modules.

Example:

You want to add a new user to your FRCLS2681 Linux host.

1. From the FRCLS2681 host menu, select Operations > Operating System > UsersActions
> Users.

; http:/ TrelsB004frelbullir - Bull System Manager 1.0.2 - Console - Microsoft Intemet

onsole "T'l""’.

L. Fila Views Tools w2 B R Al =
@ Map {Hl Hozts = HOST: frols2681 2
@ Alents {5 J1F Ao Operations
i Operating Svatam =
= M ncis281 S5HTelnet
I i e Lasl Updated: 18-10.2002 113330
ﬁ FileGrstirns hell | I.r:-dabgdle:\en' 420 seonnds
B i i .
L e ISSVSETE tatye  LastCheck  Duration Information
) ] ¥ — =
: ugmlug blu.'..'.. 5 -m“hmm“m 0d 20nam 25 ERIS OK - Packetlasz = 0%, RT4 =
| B SrsternLoad
D | | =B FroLSEDDS 3 g
@ Ol s remaster mEn
0 ER - I SysternLog
det Config
other
=]
v
L8] hickpe | rcksa00¢ Frol bull friBSMpconsolefheading-phojfiarapper phn?0S=lnuaret_name=frdszsal.felbolfréhost| | | |8l Locd inerenet e

Figure 2-14 Launching Webmin window

A Webmin page opens and prompts you for a user / password. As Administrator, you can
connect as root, with the corresponding Linux password.
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Figure 2-15 Webmin login window

Note  If the Linux host is running in SSL mode the following message appears, before the
Webmin login page:
This web server is running in SSL mode. Try the URL
https://<hostname>:10000/ instead.

You must click the link indicated in this message.

You are now in the Webmin page that manages Users and Groups:

B reedback | ¢ ¢ Log Out B

€0 60 0L O LS

Webmin System Servers Networking Hardware Cluster Qthers

Figure 2-16 Webmin interface on Linux hosts

2. Add a new user by clicking Create a new user.
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2.5  Managing Hardware

2.5.1

Using the System Native Hardware Manager

Hardware monitoring and management - such as temperature or voltage monitoring,
remote power control, access to BIOS or system logs - is not directly performed from Bull
System Manager.

Each type of server has a dedicated hardware manager that Bull System Manager uses to
perform these operations. Bull System Manager provides the appropriate menu item for
each server type, that is:

PAM for NovaScale 5000 and 6000 series

ISM for NovaScale 4000 series

CMM for NovaScale Blade series

ExpressScope for NovaScale R400 or T80O series
RMC or ARMC for Express5800 Series

Any other manager that can be accessed via a URL.

Notes

The corresponding Hardware Manager MUST be installed and configured. Please
refer to the documentation delivered with the server for details.

When the Hardware Manager is launched via a URL (Web GUI), the browser on the

console must be configured to access this URL without using an HTTP proxy.

Connection to PAM, ISM, RMC, ExpressScope and CMM hardware managers
requires authentication.

Logins must be defined in the management modules before they can be used by Bull
System Manager.

CMM : only one session is allowed per user. You must therefore register one user for
each Bull System Manager Console (used when the Manager GUI is launched from the
Management Tree).

NovaScale Blade hardware monitoring is performed through the CMM SNMP
interface. You must therefore declare the Bull System Manager server as SNMP
Manager when you configure the CMM.

To manage hardware, proceed as follows:

Step 1: Declare a HW manager and the hosts or platforms it manages.

Step 2: Reload the monitoring server to take the modifications into account.

Step 3: Call the HW Manager from the Tree pane.

Chapter 2. Getting Started 23



24

Example: Calling a configured PAM Manager:

The Operations > Platform > Hardware Manager GUI item appears in the menu of the
nsmaster host.

) Fila Yiews Tools 4 B R oA o i
o Map |G Hosts I HOST:nsmaster 1
® Alerts o [l Acc_iva LR LLLE
w8 frelzZEE1
# & FRCLSEDDS Last Updated: 14-10.2002 1125200
Updated even 120 seconds
& Ml nsmaster Duurattion Information
2 8 n METE2D rismashar Od0hi0misags CdOni9m 33z FNG O - Packet loss = 0%, RTA = 000 ms
{
|
|
v
LI | bt fFrcks3004. Frel bl FrjBSM e crsclafheading-phodwrappee pho?05S=windowsaret_name=129,162 6. 1508host=nsmastersnodetypa| | | [ Local inkranat e

Figure 2-17 HW Manager GUI menu

Activating the Hardware Manager GUI menu item calls the associated PAM Hardware

Manager:
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Status
Events Bl

B%

L

PAP
PAM Wigh Site

+o4 ] SPEFanBoxes
LERO PME

(51| 0 MODULE_1
3
(4 Histary Manager

rvicing Tools

Sel
%A Configuration Tasks

Figure 2-18 PAM Hardware Manager - Home Page

See the Administrator’s Guide for details.

2.5.2 Using the Bull System Manager Hardware Management
Application

Bull System Manager also provides its own Hardware Management application that can
be used instead of the native hardware managers (e.g. PAM, CMM ...). The Bull System

Manager Hardware Management application gives the same look and feel for all
hardware operations, independently of the target server type.

The application manages Power Control, and displays FRUs, Sensors and System Event

Logs for Express 5800, NovaScale R400 & T800 series and NovaScale 4000, 5000 and

6000 series servers.

To start the application:

From the Console Management Tree, click the Operations > Platform > Power Control item
in the host menu.

Chapter 2. Getting Started
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vy

L]
. Fila Wigws Tools ¢l ) B B mll= ah
@ Map (@l Hosts fl HOST:nemaster 1
@ perts o [l Acc_Hva Oper ations
4 - Flatform = | Operating Systam =
B TrelsZEE :DF'c-\mzr Condrol
# B FRCLSEDDS | Hardware Manager o Last Updated: 14-10.2002 115700
—— _ Updatad evers 120 seoonds
- [l nsmaster ; i
BSMTools || Host Status Last Check Duration Information
. a NETE20 rismastar UPSS Od Ch2m 1sago  OdOh 23m 35z PING O - Packet loss = 095, RTA = 000 ms
Other
i
v
5] Fretpad ffrckea004. Frel bl FrlESMiconsiafhe ading- phofrappes phoPOS=sindowsanet_nama=129.162.6, 1S06host=nemasterbnodetyps | | W Lacd ieranat P

Figure 2-19 Launching Remote Hardware Management window

Host Selection Action Pane

Display Pane

Host prog

Figure 2-20 Remote Hardware Management window
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The Bull System Manager Remote Hardware Management application window is divided
into the following functional parts:

Host Selection Pane  allows you to select the current host from all declared Express 5800,
NovaScale R400 or T80O series and NovaScale 4000, 5000 or
6000 series servers.

Action Pane displays the hardware operations that can be performed:
- Power control functions
- FRU visualization
- Sensor visualization

- Event log visualization

Display Pane displays parameters forms, messages and command results.
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2.6  Following a Performance Indicator over a Large Period

It may be interesting to follow the evolution of certain performance indicators over a large
period (e.g. the evolution of the memory use).

Performance indicators can be collected from Bull System Manager monitoring data or
SNMP protocol, as described below.

To collect and visualize performance indicator reports, proceed as follows:
1. Launch Bull System Manager Console from the Bull System Manager Home Page.
2. Click the Reports icon to display the list of all available reports.

3. Select the report you want to display from the indicators list.

/fcoda - Bull System Manager 1.0.1 - Repork - coda - Micros:

To display a repord, click on an indisater report

Indicator reports

Host Name Source
beed decicnicd SystemLoad CRU (six)
factary_hwd beed eriflement SystemLoad CRU (six)
beed ghoresd SystemLoad. CRU (six)
frol=5208 cpu irclz5308 Systemboad CPU (windows)

Figure 2-21 Bull System Manager Reporting Indicators Home Page
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The following display appears:

e ey 2y
J File Edit ‘“iew Favorites Tools Help “Ac_ldress| a"|

-

SystemlLoad.CPU on FRCLSS35208

The statistics were last updated Friday, 20 lay 2005 at 13:27

"Daily' Graph (5 Minute Average)

52.0 : P‘Iay ;20:2005 :135:2?
39.0
=
g 26.0
B
13.0
0.0
6 & 10 12 14 156 18 20 22 o 2 4 & & 10 17

Max 500 Awverage 130 Cutrent 140

"Weekly' Graph (30 Minute Average)

36.0 : : - E : May 20 2005 153:2.'-"

Hused
[
o
E=4

Max 330 Awerage 130 Cutrent 210 —

"Monthly' Graph (2 Hour Average)

3.0 : May 20 2005 12:32
24.0 SONRONRUHIN WOl USO8 WSSOSO OO S—
s H g
2 160 JEE... etk T [ e
EX3
8.0 ............
0.0
Week 16 Week 17 Week, 18 Week 19 Week, 20 LI

Boite de récepkion - Micr... | @ F:\Inetpublwwiwrooti o, ., | @ UserGuideMSmasteryd .., | ﬂd Internet Ex

Figure 2-22 Bull System Manager Reporting Indicators - example

This display shows four graphs (three are visible in the example). Each graph shows the
evolution of an indicator (here CPU load) for different periods (daily, weekly, monthly and

yearly).

2.7 Bull System Manager Configuration

Please refer to the Administrator’s Guide for details about configuration tasks.
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Chapter 3. Using Bull System Manager Console Supervision
Modes

The Bull System Manager console provides three supervision modes, each providing its
own representation of the Bull System Manager monitored resource:

e Tree mode
e Map mode
e Alerts mode

Whatever the mode, the characteristics of a selected monitored resource are automatically
displayed in the Supervision Pane.

Note For further information about Console Basics and Console Security Access, refer to Console
Basics and Bull System Manager Authentication and Roles.

3.1 Working in the Tree Mode

When you select the Tree radio button, a Management Tree is displayed in the Supervision
Pane.

3.1.1 Management Tree Basics

The Management Tree is a hierarchical representation of the resources defined in the Bull
System Manager configuration. Each resource displayed in the tree is represented by a
node that may have subnodes.

ﬂ Hosts

=-JBl BSMTESTY

ng;" EventLog

- . Application
. Security
Lo i) Systemn
-G Internat

@ LogicalDisks

Figure 3-1  Management Tree
e Double<lick a node or click the +/- expand/collapse icon to display subnodes.
e Select a node to display automatically its characteristics in the Supervision Pane.

e Rightclick to display the specific node menu.
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{(ll Hosts
=l copa
¢ EventLog
— Application
) Security

0 Syster
: ogicalDi
checkatributes  [RAN

+- Systemlce

+

Figure 3-2 A service node menu

Upper the Management Tree, a menu provides the File, Views and Tools commands:

File “iews Tools IQ O @ | i-]Tj

Load... Systermmiolr k HardwareManaoers
Reload master HostGroups

Close Hosts

Hide Tree StorageManagers

Figure 3-3  Management Tree menu

Management Tree Menu

File  ->load Selects a view to be loaded.
->Reload Reloads the current view if the configuration has been
- Close modified.
>Hide Tree Closes the current view.

Hides the tree to display the whole Supervision Pane

Views Displays the list of all loaded views: you can select one view.
Tools -> Find Allows you to search a node in  [IIMEEEEIETE x|
the current view according fo its ]
name or pcrt Of its name. [~ Startfram Root ¥ Circulate
" Starts with ' Farward
& Contains " Backward
= Ends with

" Matches exactly [ Respectcase

Mext | Cancel |

it x|
modify the Management Tree EEl

animation refresh delay.
Cancel i

-> Refresh Delay  This dialog box allows you to

The default refresh delay is 120
seconds.

Figure 3-4 Management Tree commands

Note  The refresh delay is only used by the Management Tree, not by applicative panes.
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3.1.2 Management Tree Animation

The Management Tree is animated according to the following rules:

e Color is dependent on status:

Red CRITICAL
Orange WARNING
Magenta UNKNOWN
Green OK

Blank UNMONITORED

This color scheme is applicable to hosts and services.

e When a node has subnodes, the node icon is split in two. The top left triangle is

animated to represent node status and the bottom right triangle to represent subnode

status (i.e. most degraded status).

e Host and associated monitoring services node icons are animated to represent self-
status. All other node icons are animated to represent subnode status (i.e. most
degraded status).

Example:

SYSMAN (root node) and associated services are self-monitored. The top left triangle is
GREEN, showing that host status is OK (the ping operation is successful), but the bottom
right triangle is RED, showing that at least one service status is CRITICAL.

& Bl =vaman

EI:I EventLog

----- ) Application
----- ) Security
3 System

=-CF WindowsServices
83 EventLog

*

Figure 3-5 Management Tree animation - example
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Rightclick the animated nodes to display the Diagnosis and On/Off menus:

|—D System

Animation Diagnosis
Check Attributes off

Figure 3-6  Animated node menu

Diagnosis
On
Off

Example:

Displays an animation information window.
Activates node animation.

Deactivates node animation. This option is useful if you decide not to
animate a specific service or host.

Animation of the System and All services nodes has been deactivated. As these nodes are
no longer monitored, status is not propagated (icons are BLANK) and SYSMAN (root node)
status is now OK.

=Bl svsman

EEI EventLog

----- L) Security
() System
=] LogicalDisks
O Al

=23 Systemboad

=2 WindowsServices
. EventLog

Figure 3-7 Deactivating supervision - example

Note  Monitoring services are independent due to the server polling mechanism. This may create
a temporary de-synchronization during an animation refresh.
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3.1.3

Management Tree Nodes

Each Bull System Manager monitored resource is represented as a node with a specific
icon in the animated Management Tree. Management Tree nodes are animated according
to node status. When a node is selected, its characteristics are automatically displayed in

the Supervision Pane.

Monitored Resource

Icon

Description

Root Node

0

First node in the tree.

HostGroup

@

Hosts can be grouped into hostgroups. For example, an
administrator can define a hostgroup containing all NT
servers. Doing so allows you to identify quickly a host in a
degraded state, as host status is propagated up to the
hostgroup node.

Group

Groups allow you to gather other groups and hostgroups
in coherent entities. Refer to the Administrator’s Guide for
details.

Platform

A platform is a physical group of hosts of the same type.

Hardware Manager

P

Several hardware managers can be displayed:

- PAM Manager for NovaScale 5000 and 6000 Series
Platforms.

-  CMM Manager for NovaScale Blade Series Chassis.
- ISM Manager for NovaScale 4000 series Platforms.
-~ ESMPRO Manager for Express 5800 hosts.

- RMC manager for Express 5800 hosts.

—  Any other hardware manager.

Storage Manager

fas

Two storage managers can be displayed:
S@N.ITI Manager for shared host storage via a SAN.

Any other storage manager.

Host M ia6a A host is composed of categories.
-ﬁ ia32
@ other
Category o A category contains specific monitoring services. For
example, the Systemload category contains the CPU
service and the Memory service.
Service 0 Each service belongs to a category.

Table 3-1.  Management Tree nodes

Note  Currently, NovaScale 64 bits is applicable to NovaScale 4xxx, 5xxx and éxxx servers and
NovaScale 32 bits is applicable to NovaScale 2xxx and Express 5800 servers.
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3.1.3.1

3.1.3.2

36

Root Node

The Root node is the first node in the tree. The top left triangle reflecting self-status is always
blank (unmonitored). The bottom right triangle reflects the most degraded subnode status
(host and services).

0] Root node menu

Expand Shows a tree view of all hosts, hostgroups or managers in the
configuration.

Animation Briefly explains resource status.

Table 3-2. Root node menu

Hardware Manager Node and Status Levels

A Hardware Manager node represents one of the hardware managers listed in Table 3-5.

PAM and CMM Managers Status Levels

The top left triangle reflects self-status and the bottom right triangle reflects the most
degraded subnode status (hosts and services), as shown in the following table:

Manager (PAM, CMM) Status Levels
Status Description
PENDING The service has not been checked yet. Pending status occurs only
(gray) when nagios is started. Status changes as soon as services are
checked.

- The manager is up and running.

WARNING The manager has a problem, but is still partially up and running.
(orange)

An internal plugin error has prevented status checking. An
unknown status is considered as a warning status.

The manager has a serious problem or is completely unavailable.

Table 3-3. PAM and CMM status levels
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RMC Managers Status Levels

The top left triangle reflects power status and the bottom right triangle reflects the most
degraded subnode status (hosts and services), as shown in the following table:

Manager (RMC) Status Levels
Status Description
PENDING The service has not been checked yet. Pending status occurs only
(gray) when nagios is started. Status changes as soon as services are
checked.

The power status is on.

An internal plugin error has prevented status checking. An
unknown status is considered as a warning status.

The power status is off.

Table 3-4. RMC status levels

ISM and ESMPRO Managers Status Levels

The top left triangle reflecting self-status is always blank (unmonitored). The bottom right
triangle reflects the most degraded subnode status (hosts and services).

Eﬁ Hardware Manager node menu

Expand -> PAM manager Shows all NovaScale 5000 and 6000 Series
platforms managed by this PAM manager.

-> CMM manager Shows all NovaScale Blade Series Chassis managed
by this CMM manager.

-> RMC, ISM or ESMPRO  Shows all hosts managed by these managers.

-> other managers Shows all hosts managed by these managers.

Animation Briefly explains resource status.

Table 3-5. Hardware Manager node menu
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3.1.3.3 Storage Manager Node

The Storage Manager node represents either the S@N.IT! Manager or any other storage
manager.

The top left triangle reflecting self-status is always blank (unmonitored). The bottom right
triangle reflects the most degraded subnode status (hosts).

Eﬁ Storage Manager node menu

Expand Shows all hosts managed by this manager.

Animation Briefly explains resource status.

Table 3-6. Storage Manager node menu

Note  The S@NIT Web GUl is based on a java applet technology. So, do not close the first
launched browser windows, which does not contain the GUI but the applet itself.

3.1.3.4 Platform Node and Hostgroup Node

A Hostgroup node represents a group of hosts. A platform node is a specific hostgroup
node, which represents a group of hosts of the same type.

The top left triangle reflecting self-status is always blank (unmonitored). The bottom right
triangle reflects the most degraded subnode status (hosts and services).

€8 Platform node and & Hostgroup node menu
Expand Shows the hosts contained in this hostgroup or this
platform.
Animation Briefly explains resource status.

Table 3-7. Platform node and Hostgroup node menus

3.1.3.5 Host Node and Status Levels

A Host node represents a single host. The top left triangle reflects self-status and the bottom
right triangle reflects the most degraded subnode status (services).

Host Status Levels

Status Description

PENDING (gray) |Host status is unknown because no associated service has been
checked yet. Pending status occurs only when NetSaint is started.
Status changes as soon as at least one associated service is checked.

The host is up and running.
The host is down or unreachable.

Table 3-8. Host status levels
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3.1.3.6

3.1.3.7

B @ BEHost node menu
Expand Shows all monitoring categories associated with this
host.
Animation -> Diagnosis Briefly explains resource status.
->On / Off Activates / deactivates node animation.

Table 3-9. Host node menu

Category Node

A Category node contains specific monitoring services.
The top left triangle reflecting self-status is always blank (unmonitored). The bottom right
triangle reflects the most degraded subnode status (services).

& Category node
Expand Shows all monitoring services belonging to this category.
Animation Briefly explains resource status.

Table 3-10. Category node menu

Services Node and Status Levels

A Services node is a leaf node.

The service node reflects the service status computed by the monitoring process, as shown

in the following table:

Service Status Levels

Status Description

PENDING (gray) | The service has not been checked yet. Pending status occurs only
after NetSaint is started. Status changes as soon as services are

checked.
_The monitored service is up and running.
WARNING The monitored service has a problem, but it is still partially up and

(orange) running.

An unreachable or internal plugin error has prevented service
status checking. An unknown status is considered as a warning
status.

The service has a serious problem or is completely unavailable.

Table 3-11. Service status levels

Service node menu

Animation -> Diagnosis Briefly explains resource status.

-> On / Off Activates / deactivates node animation.

Table 3-12. Service node menu
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3.1.4

40

Management Tree Views
Management Tree views allow you to represent monitored resources according to your
needs at a given time. The Management Tree provides four standard views:
e Hosts
¢ HostGroups
e HardwareManagers

e  StorageManagers
The default view is the Hosts view, but you can load another view by selecting:
File > Load > SystemMgt > view name

Once several views have been loaded, you can switch from a one view to another by
selecting:

Views > view name

Systembigt i Hosts
Systernmgtf HostGroups
Systembigt f Storageianagers

Standard Tree Views

Hosts View All hosts are displayed under the root node.

HostGroups View All hostgroups in the configuration plus all NovaScale
5000 and 6000 Series platforms and NovaScale Blade
Chassis are displayed as hostgroup nodes with their
associated hosts.

HardwareManagers View  All hardware managers in the configuration are displayed.
Each manager node contains the hosts that it manages. For
example, the PAM manager nodes contain the NovaScale
5000 and 6000 Series platforms and the CMM manager
nodes contain the NovaScale Blade Chassis.

StorageManagers View All storage managers in the configuration are displayed.
Each manager node contains the hosts that it manages.

Table 3-13. Tree views

Note  As Administrator, you can create customized views to meet your own criteria. Please refer
to the Administrator’s Guide for details.
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3.1.4.1 Hosts View

The Hosts view is the default view. All the hosts in the configuration are displayed with their
monitoring services classified by category (Eventlog, LogicalDisk ...), as shown in the
following figure.

ﬂ Hosts

=& BSMTESTH
5} EwventLog
5} LogicalDisks
;? Svstemboad
@' WindowsServices

ML FamEODD_DIDD

Bl FRCLE2681

L Pam1

L Pam2

-Jll PROTOA

-Jll TIGER_51

e o e e [

Figure 3-8 Hosts view

3.1.4.2 HostGroups View

The HostGroups view displays all the hostgroups in the configuration.
Hosts are displayed under each hostgroup, with their monitoring services classified by
category (Eventlog, LogicalDisk ...), as shown in the following figure.

ﬂ HostGroups

- I FAMEDOD

EI% Lire

=Bl FrRoLs 2681

=g PROTOY

EE Systemigt

EI% Wind oS
&l BSMTESTY
w-Jl FamEnon_oioo
---. PROTOS
m-JJfl TIGER_S1

Figure 3-9  HostGroups view

In the example above, the administrator has defined a Windows hostgroup grouping all
Windows servers. The bottom right triangle of a hostgroup icon is not green, meaning that
a host or a service has a problem. The operator can expand the hostgroup icon to identify
the host or service with a problem.
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3.1.4.3 Hardware Managers View

The HWManagers view displays all the managers in the configuration:

e PAM Managers, displaying NovaScale 5000 and 6000 Series platforms with their
hosts (domains)

e CMM Managers displaying NovaScale Blade Chassis with their hosts (NS 20x0)
e RMC, ISM or ESMPRO Managers displaying other hosts.

Hosts are displayed with monitoring services classified by supported category (Hardware,
Eventlog, LogicalDisk...), as shown in the following figure:

ﬂ HW Managers
BT ChM
IJ:'I—% chassist

=Bl blade
FileSystems
Hardware
LinuxServices

Syslog

SystermbLoad
=HEL bladez
IJ:'I—cf‘ Hardware

L3 Health
=HEL blades
=T PANI

IJ;'I—@ farmne-ptf1

-l famenno

LogicalDisks
Systemload

WindowsServices

Figure 3-10 HW Managers view
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3.1.4.4

Storage Managers View

The Storage Managers view displays all the storage managers in the configuration.

Hosts are displayed with monitoring services classified by supported category (Storage,
Eventlog, LogicalDisk ...), as shown in the following figure:

m Storage Managers
-G NEC-STORAGE

-l famenoo

G Eventlog

LogicalDisks
Systermbload

WindowsSemnices
E-Tad SAMITY

IJ:'I—C@ Storage
L& sanitstatus

len

Bl delphi
Bl hadock
B pegase
B punch
Bl ulysse

Figure 3-11 Storage Managers view
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3.2  Working in the Map Mode

When you select the Map radio button, the Map, Focus and Problem Panes are displayed.

Note  The Map and Problem panes are always synchronized.

e The Problem pane lists the problems that occurred on hosts belonging to hostgroups on
the current map. Each hostgroup is represented by an animated rectangle (rectangle
dimensions are specified in the Configuration GUI). The Select a map box allows you
to select another configured map.

e The Focus Pane lists all the services (with their status) configured to be displayed in this
pane. As Administrator, these monitoring services are highly important and need to be
displayed in a specific pane. This pane appears only when configured focus services
exist. (See the Administrator’s Guide for more information).

hlap Hadio

Focus Pane

Ot B T - Bl Sy stems PAanBger 10L2 - Canesle - PRcrasolt Tnoemet Enplat

onsole e o

T“‘"J/ G ORD . M
Wiy m anpateiiiny |68 MBS ¥

-

Sywtanlasd TP on AR HYH : Trssaut whis
sHarpting cannaction

EvartLog Sywian oo RCLSE | 4 ranes svintc
ke i 10

Problem Fane

S MO TOENNA detasd_map

E " Husiaimg
abiich Croard b TSt sl (B E
Beevizn dutalls Dortited v 10 sqrirets
Heel Senvien Stalus - LastCheck | Dsrallen Isfanmatian
_ AR ey i mwmm:up D rnany  THROLE e alerping
! Spaie Erdnt Y v imite e o sty R4 e ehegin
Sraturd pmd ) m DthimAlrage Dddhim3ae oo wide soreing
ERESE S crinca [T PEAETE SR e -
B T e ket i

Figure 3-12 Map mode

In the Map Pane, hostgroups and hosts are displayed and animated with their computed
status. Their positions (x,y) are specified in the Configuration GUI.

Hostgroup status is the most degraded status of corresponding hosts and monitoring
services.

The Problem Pane lists all the problems that occurred on any host belonging to the
hostgroups on the map. You can navigate thru Internet links and return using the Back
button.

Note For each Map, a corresponding internal hostgroup (with name = <MapName>_map) is
generated for the monitoring server (used by the Problem Pane).
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If you want to zoom on a specific hostgroup or host, select it on the map. When the mouse
is hovered over a square representing a hostgroup, an Infotip displays the hostgroup name
and position (x,y):

(4]
(V]
=

Status Overview | Status Grid | Status Detail |

Services detail

frizlz2 101 frolbull ft Evertloy Application m Oc0Oh 2m 35 ago  0d Oh 16 555 2 new events for the last 30 mnl

2

position: {ine : 18, calm 7] _

Aletts

Host | Service |- Status | LastCheck | Duration Information
FRCLS2703 Everdlog.Security 5 0d0h1m47sago Od1h 36m 35z 110 new events for the last 30 mol

FRCLS3104.fr.a0.bull.net Ewentlon Application 5| 0cd0h2m 30s ago Od Oh 52m 255 28 new events for the last 30 mol

Figure 3-13 Hostgroup details

When a hostgroup is selected, the status of all the hosts belonging to that hostgroup are

displayed, along with three links to more information:

Hostgroup name link (perso in the figure below):

This link opens a new window giving grid status information about all current
hostgroup host services.

T3 HOSTGROUP: perso
ng |

| Status Overview | Status Grid | Status Detail |

Brs

:

Host

%]
@
5
=]
]
-]

Figure 3-14 Hostgroup link information
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e Host name link (Frcls2101.Frcl.bull .fr in the figure):

This link opens a new window giving monitoring information about all current host
services.

@_ HOST: frels2101.frclbullfr i
Maonitoring
| Host Status | Services Status | Control |

Semvices detail

Senvice Status Last Check Duration Information

EventlLog.Application Ol Oh1m 13z ago OdOh21m 7= 2 new events for the last 30 mn!
Evertl o Security oK Od Oh Om 17z ago  Od Ok 25m 113 OK: no new everts for the last 30 mn
Eventlog. Em oK 0d Oh 5mBsago 0dOh25m1s  OW: nonew events for the last 30 mn

CONMECTION ERROR - NS Master Managemert Agert MOT
LogicalDizks All 0d Oh 4m 425 ago 1d3h17m 3= LISTENING : cannot connect socket for host

frolz21 01 frclhull fr and port 1246 - Connection refused
(il oK 0d Oh 3m 56z ago 1d3h17m1s  PING OK - Packet loss = 0%, RTA =0.00 ms
SystemLoad CPU oK Ocl Oh 3m 23z ago  Oc Oh 23m 172 CPU Load OK (1mn: 19 (10mn: 2%

Memory Usage OK (total: 24670 (used: 352Mb, 149%) (free:
Systemload Memory oK Od Oh 2m 53z ago  Od Oh 22tm 463 2115Mb) (phiysical: 1022Mb)
‘WindowsServices EventLog oK 0d Oh 2mBsago OdOh22m1s  OW:'Eventlog'

Figure 3-15 Host services

e  Alerts link;

This link opens a new window giving alert information about all current hostgroup host
alerts.

g HOSTGROUP: perso
Reporting
| Alert History | Kotifications | Availability | Indicators Trends |

.
g [perso Alerts fype Hosts and Services =] [ wat admowledged j
@ I’“‘ALLHDSTS T Alerts lavel Al - p Histary

o) |""ALLSEHVIEES = Report Period | Last 7 Days -l
ax Items: W Apply | Reset |

Ll 1) 1

Matching Alerts Date/Time Server: 21-04-2005 17:04: 21
Time Host Sernvice State  Count Information

21-04-200517:00:09  FRCLS2703 Evertlog Security Ok 1 OK: no new events for the last 30 mn

21-04-2005 16:55:33  frcls5504 frelbull fr Eventl oo Security 1 945 newy everts for the last 30 mnl

21-04-2005 16:50:29  frcl=5504 frelbull fr Eventl oo Security 0k 1 Ok no newy events for the last 30 mn

21-04-2005 16:39:53  frols2101 frelbull fr Eventl oo Application 1 2new events for the last 30 mn!

21-04-2005 16:38:59  frcls2101 frelbull fr ‘WindowsServices Fventl og Ok 1 Ok 'Evertlog

21-04-2005 16:38:14  froks2101 frelbullir SystemLoad Memory oK 1 :1:1":\:‘;" t':Jg?ff:;:(t;:fg;:?i:h?sﬁz:ﬁonmm

21-04-2005 16:37:43  frcls21041 frelbullfr Systemload CPU 0k 1 CPU Losd O (1mn: 2%) (10mn; 2%

21-04-200516:33:59  frol=21 01 frelbull fr Evertlog System Ok 1 OK: no new events for the last 30 mn j

Figure 3-16 Hostgroup alerts
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3.3 Working in the Alerts Mode

3.3.1 Alert Basics

The Nova Scale Master Alert Viewer application displays monitoring alerts (also called
events) concerning a set of hostgroups, hosts and services.

The application provides filter functions in order to display alerts on all monitored resources
or on only a subset of these resources.

Whenever a service or host status change takes place, the monitoring server generates an
alert, even when status passes from CRITICAL to RECOVERY and then to OK. Alerts are
stored in the current monitoring log and are then archived.

The Bull System Manager Alert Viewer application scans the current monitoring log and
archives according to filter report period settings.

 ALERTS
Reporting
| Alert Viewer |

ELE[I“ALL HOSTGROURS = ;I Alerts type Hostz and Services vI O Mot acdknowledged

@ IxxALL HOSTS = ;I Alerts level Al - |_ History

P Report Period |Last 7 Days I
O I ALL SERVICES ™ vI ! 2 ¥
bl ax Items: I‘] [ Apply | Reset |

Matching Alerts DiatesTime Server: 02-05-2005 14352
Time Host Service State  Count Information

02-05-2005 14:36:24  frels3104 Evertl og.Application AARNING 2 4 newy everts for the last 30 mnl

02-05-2005 14:33:30  namaster Evertl og.Security W 1 connect | Connection timed out

02-05-2005 14:33:05  namaster WindovwsServices Evertl og W 1 connect | Connection timed out

02-05-2005 14:32:40  namaster Evertl od.Application 1 connect | Connection timed out

02-05-2005 14:3210  namaster Systeml oad Memary 1 connect | Connection timed out

02-05-2005 14:31:40  namaster Systemload CPU 1 connect | Connection timed out

02-05-2005 14:31:00  nsmaster PIMG 1 PING CRITICAL - Packet loss = 100%
CONMECTION ERROR - HOST DO OR UNREACHABLE :

02-05-2005 14:30:10  nsmaster Looicalbisks Al 1 cannot connect socket for host nesmaster and port 1246 -
Connection timed out

02-05-2005 14:30:04  nemaster-rme RMC PovverStatus 1 Chassis Power iz off

02-05-2005 14:29:47  namaster Eventl og.System 1 connect : Connection timed out

02-05-2005 14:28:47  nsmaster (EE 1 PING CRITICAL - Packet loss = 100%

02-05-2003 10:3210  frels3104 Eventl og. Securit oK. 1 OHK: no newe events for the last 30 mn

Figure 3-17 Nova Scale Master Alert Viewer

Nova Scale Master Alert Viewer is divided into two main functional parts:

o The Selection Pane, where dll filters are taken into account like a logical AND.
Exception: when the Alert level is set to display Current problems only, the Time Period
is automatically set to This Year, and cannot be modified.

e The Information Pane, which displays filtered alerts.
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3.3.2 Alert Selection

Note By default, alerts for all hostgroups, all hosts and all services are displayed.
Eg [*aLLHOSTGROUPS = =] Alerts type Hosts and Services = [ Hot acknowledged
& [ALCHoSTS = I [t - =l T history
(3 [~ ALL SERVICES = = Report Period | Last 7 Days =]

hd ax ltems: |‘|5 Apply | Heszet |

Figure 3-18 Alert Selection

Selecting Hostgroups, Hosts and Services
You can filter hostgroup, host and service Alerts from the Selection Pane, in any
combination:

e When you select a specific hostgroup, only the hosts belonging to that hostgroup are
selected.

e When you select **ALL HOSTS**, all the hosts belonging to the previously selected
hostgroup are selected.

e When you select a specific host, only the services belonging to that host are selected.

e When you select **ALL SERVICES**, all the services belonging to the previously
selected host are selected.

e When you select **ALL HOSTS** and **ALL SERVICES**, all the hosts belonging to
the previously selected hostgroup (or all hostgroups) are selected and all the services
belonging to those hosts are selected.

Example:

@E I MS_Master
Q I nEmaster

2 | Spstemload CPU

3 | KA R

Figure 3-19 Alert selection - example

In this example, the user has decided to select all alerts concerning SystemLoad.CPU on the
nsmaster host in the NS_Master hostgroup.

Selecting Alert Type

You can filter alerts according to the following alert types:
-~ Hosts and Services
—  Hosts
—  Services

Note By default, Hosts and Services is selected.
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Selecting Alert Level

You can filter alerts according to the following alert levels:

e Al
Displays all alerts.

e Major and Minor problems
Displays host alerts with DOWN or UNREACHABLE status levels.
Displays service alerts with WARNING, UNKNOWN or CRITICAL status levels.

e Major problems
Displays host alerts with DOWN or UNREACHABLE status levels.
Displays service alerts with UNKNOWN or CRITICAL status levels.

o Current problems
Displays alerts with a current non-OK status level.

When this alert level is selected, the Time Period is automatically set to ‘This Year’ and

cannot be modified.

Note By default, All is selected.
Selecting Acknowledged Alerts
As Administrator, you can acknowledge alerts and decide whether they should be
displayed or not.

| Acknowledge icon |
02-05-200515:3224  nsmaster Eventl oo Application O m 1 3 nesy everts for the kst 30 mol

Figure 3-20 Acknowledged alerts selection

Note By default, All alerts is selected (acknowledged or not).

Selecting Alert Histories

By default, all the alerts concerning a particular service of a particular host with a given
status level are displayed in a single line:

e The Count field lists the number of similar alerts over the specified Report Period.

e The Time field displays the time when the most recent alert was generated.

e  The Information field details the most recent alert.

When you select this option, each alert is displayed in a different line:

e The Time field displays the time when the alert occurred.
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Selecting Time Periods

The user can specify the period of time over which alerts are displayed:

e last 24 Hours

e Today

e Yesterday
e This Week
e last 7 Days
o Llast Week
e This Month
e Last Month
e This Year

e last Year

e *CUSTOM PERIOD*

When you select *CUSTOM PERIOD*, you can specify time period start and end dates.
The default *CUSTOM PERIOD* setting is the beginning of the current month through to the
current date.

Note By default, alerts over the Last 7 Days are displayed.

Selecting Max ltems

This option allows you to specify the maximum number of lines displayed.

Note By default, the Max Items setting is 15.

3.3.3 Alert Information

Alerts give the following information:

e Time when the alert occurred

e Host Name where the alert occurred

e  Service Name where the alert occurred
e Status Level

e Count

e Information

Note  The Count field is always set to 1 if the History option is set to true. Otherwise, the Count
field indicates the number of alerts with the same status level. Time and Information fields
concern the most recent alert.
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3.4

3.4.1

Supervision Information

Supervision Information Basics

The Supervision Pane displays information about monitored resources and works exactly
like @ WEB browser. You can click a link, retrace your steps (back, forward), reload a
page, detach a page and print a page. The Supervision Pane is divided into five functional
parts, as shown in the following figure:

Menu level3

| Tool Bar | Title Area

1

00 32 .8 \ \ .
[ HOST:frois6260 i

e |t = | Operating System= |
System |
b Process I Ok Unknown

E: R

RPM Producls |
= T Lo | Click on status links to display the selecied senicas

Information
area

. . Last Upd ated: 23-02-2006 142153
Service details Undated sweiy 120 seconds
Senvice Status Last Check Duration Information
FlleSyztams All 1[4 Oz O 2m 252 ago Od dh17mds g&sﬁ?;;f dizks =22 hen
Unpiale to get the URL of the:
Hardware Health Oc O Oem 592 ago  Od 4h 21m 34 PAM menager on
codairel bl i

Ol - 1 processes running with

LinuxSerdices syslogd 0E Od O im 14z ago Oddh20mdgs Joo C 0 syziogd
P DK 0d0nSmi4zago Cd4n19mETs Rh oh oy noketloss = 0%,
Slorane SanitStatis 06 0F 20 258 g0 0d 4h 19im 108 ;’%ﬁﬁu host is unknown in

Syziog AwthentFailures OciO 2m 25z ago Od dh18m 2z (Service Check Timed Out)
CPU Ublizetion: 1% (1mn), 4%

Sysierl oad CPI UL Oc Of 2 252 a0 0d 4h 17m 345 Smm, 1% (15mn)
Status; 0K - (lotal: BOZANE)
Syztemioad Memony 1[4 Ocf O im 52z ago Od dh 21m 28s  (u=edd 1586Mb, 27%) (Tree
A4520b) (phyysacat J007ME)
Sysimrlond Processes 0K Od0h1m 12z ago  Od 4h 20m 38s O - 99 processes running
Systerl nad Users 0k OEtnSnSzagn  Oddni1SmSis :'égg';dslg“ - T users currertly

Figure 3-21 Supervision Pane

Tool Bar

Title Pane

E3 Go back one page

E2 Go forward one page

[2] Reload the current page

Modify the information pane refresh delay
L2 Reload the first page

Detach the current page to a separate frame

Displays the selected monitored resource icon, type and name.

L |
L, Only available for hosts. Gives a short description of the selected
host (name, model, OS, netname and domain).
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Menu Level1 Allows you to select the type of functional domain you want to access,
according to the selected resource: Monitoring, Reporting, Inventory,
Operations.

Menu Level2 Allows you to select the information or operation you want to access,
according to selected Level1 information.

Menu Level3 Allows you to select the information or operation you want to access,
according to selected Level2 information.

Information Pane  Displays selected information about the selected resource.

3.4.2 Monitoring Information

The following table lists the available information types and associated supervision scope.

Information Type Supervision Scope

Status Overview Root nodes of Hosts and Hostgroups Views (Tree)
Hostgroup

Status GRID Root nodes of Hosts and Hostgroups Views (Tree)
Hostgroup

Status Detail Root nodes of Hosts and Hostgroups Views
(Management Tree)
Hostgroup

Host Status Host

Service Status Service

Network Outages Not yet supported

Config Root nodes of Hosts and Hostgroups Views (Tree)

Log Root nodes of Hosts and Hostgroups Views (Tree)

Control Root nodes of Hosts and Hostgroups Views (Tree)

Table 3-14. Monitoring information

3.4.2.1 Status Overview

This screen allows you to view the current status of all monitored hosts and services.

e When you launch this screen from the hostgroup node, a status overview of all
hostgroups (or a particular hostgroup) is displayed.

Hostgroups Overview

Host Group Host Status Totals Service Status Totals

16 0K
NS Master 2R { AR HING

16 0K
default_map 2P 1 AR NING

Figure 3-22 Hostgroup Status Overview
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3.4.2.2

Host Group Hostgroup name
Host Status Totals Number of hosts classified by status level in the hostgroup
Service Status Totals Number of services classified by status level in the hostgroup

e When you launch this screen from the host node, a status overview of all hosts is
displayed.

Hosts Overview
Host Status Senvices
frole3104

nzmaster

nemaster-
rimc

Figure 3-23 Host Status Overview

Host Host name

Host Status Host status level

Service Status Number of services classified by status level
Status GRID

This screen displays the name of all the monitored services for each host.

Figure 3-24 Host Status GRID
Host Host name

Service Status Host services animated by status level color
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3.4.2.3 Status Detail

This screen gives detailed information about selected hosts and/or services.

All

Host
Selection

]

Selected Host
Services

Host details

Host Status
frels3104 (]2

nsmazter lg

nsmaster-rmc up

1 17

Click status links to display the selected hosts and services

Last Check
Od Ok 3m 52s ago

Ocd 1h 45m 55 ago

Od 1h 43m 30z ago

3 Matching Host Entries Displayed

1 ] L]

e

Duration Information

Oc 1h 45m 37s  PING Ol - Packet loss = 0%, RTA = 0.00 ms
1 2h 30m 335 (Host assumed to be up)

1d 2h 26m 58z (Host assumed to be up)

Figure 3-25 Hosts Status Detail

The Selection Pane allows you to select host and service according to status level:

Host Selection

Number of hosts with Up, Down, Unreachable or Pending status.

You can select hosts according to status: All hosts, Problem hosts, or
Specific hosts.

Selected Host Services

Number of services with OK, Warning, Unknown, Critical or Pending
status. You can select services according to status: All services, Problem
services, or Specific services.

Information

service are selected.

Gives host details if host is selected and service details if host and

See Host Status and Service Status below for more information.

3.4.2.4 Host Status

This screen gives a detailed view of the status of the selected host.

Host detail
Host Status
frele1 04 R

Last Check
Ocd Oh 2m 82 ago

Duration
0d 1h 58m 53z

Information
PING QK - Packet logs = 0%, RTA = 0.00 ms

Figure 3-26 Host Status
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3.4.2.5

Host

Host Status
Last Check
Duration

Information

Service Status

Host name

Host status

Time since the last check occurred

Time since the current state was set

Additional information about the host state

This screen gives a detailed view of the status of all the services associated with the
selected host. Services can also be selected according to status level.

Al

Selected Host
Services

Service details
Senvice
EventLog Application
EventLog Security

Eventlog. Em

LogicalDisks A&l

Flrd

Systeml oad . CPU

Systeml oad Memory

‘WindowzServices Eventl og

Ok

Warning

2

|

Click on status links to display the seleded semices

Status
0k

(2] 4
ok

0K

ok

Ok

Last Check
Ocd Ok 1m 29= ago

Ocd Ok Om 42= ago
Ocd Ok 4m 555 ago
Od Ok 4m 83 ago

Od Ok 3m 202 ago

Od Ok 2m 332 ago

Od Ok 1m 452 ago

Od Oh 1m 14z ago

Duration
0d 2h Bm 30z

Ocl Ok Sin 312
Ocl 2h 4m 412
Ocl 2h 4m 8=

Ocl 2h 3 20s

Odl 2h 2t 335=

Od 2h 1tn 45s

0d 2h Bm 14=

Information

QK no newy everts for the
l&=t 30 mn

20 newy events for the last
30 mnl

39 newy events for the last
30 mnl

DISHS OH: all disks (2, 00
lezs than S0% wtilized
PING OK - Packet loss = 0%,
RTA =000 ms

CPU Load O (1mn: 5%
(10mn; 5%

Memory Lsage OK (total:
11620k (used: 255hb,

249 (free: 87TME)
(physical 495mb)

Ok Eventlog

8 Matching Service Entries Displayed ( fiter: Service Status PENHDING OK WARHIHG UHKHOWH CRITICAL)

Figure 3-27 Service Status

The Selection Pane allows you to select services according to status level:

Selected Host Services

Number of services with OK, Warning, Unknown, Critical, or Pending
status. You can select services according to status: All services, Problem
services, or Specific services.

Service
Status

Last Check
Duration

Information

Service name

Service status

Time since the last check occurred

Time since the current state was set

Gives status details for the selected services:
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3.4.2.6

56

Config

This screen displays the Monitoring Server (nagios) configuration objects (hosts,
hostgroups, services, contacts, contactgroups, timeperiods and commands) that you have

defined.
Ohject Type: |H-:-sts j Update
Magios initial Configuration
Hosts
o Parent Host Ena_hle Enah_le Default Naotification  Event Enable
Host Description Address Hosts Check Active Passive Contact Period  Handler Event
Command Checks Checks Groups Handler
host of
check- tmcgt-
Chlkd platfarm 192 165207 .30 : Mo Yes ] 24x7 Mo
manager hiost-alive admins
NS Master check- tmct-
FRCLE1704 ST FRCLE1704 Fostalive Mo Yes T 24x7 Mo
host of
check- micgt-
PAP platform 17231 5069 [ o Yes - 247 Mo
manager hiost-alive admins
no check- tmcgt-
blacel description 192165 207 34 i Mo Yes T 24x7 Mo
no check- -
hlade2 descriptian 192 165207 42 ot alive Mo Yes T 24x7 Mo
no check- -
charly L description 17231 5070 ot alive o Yes S 247 Mo
no check- tmct-
charly W description 17231 .50.11 host alive Mo Yes e 247 Mo
no check- tmct-
frclz0109 description frelz0109 host alive Mo Yes e 247 Mo
System check- micgt-
froled 704 rédgpvaegiemerrt frols1 704 hostoaiive O Wes admine 2247 Mla
check- tmicgt-
frclz3104 test frole3104 host alive Mo Yes e 247 Mo
no check- tmcgt-
frols6260 description frols6260 i M Yes T 24x7 Ma
ip16.50 frcl bl fr '(-&';Llﬂlfu%)“” ip16.50.frcl bl fr Mo Ves none  24xT Mo
no check- -
Iyriz description 129182657 ot alive o Yes S 247 Mo
check- tmct-
nsmaster MEC120LH n=master.frclbull fr host alive Mo Yes e 247 Mo

Figure 3-28 Monitoring Server Configuration
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3.42.7

Log
This screen displays the current Monitoring Server log file. You can also browse archived
events.

Archives log Current Event Log Current Log

o Earliest Entries First: [l

25-07-2006 00:00:0
ta
@ Fresent.. Max tems: |1 RO0 Apply |

File: dvarfoginem_nagios/inagios log

_‘!) [25-07-2006 14:36:09] SERVICE ALERT:
@ [25-07-2006 14:31:58] SERVICE ALERT:
@ [25-07-2006 14:24:28] SERVICE ALERT:

Juby 25, 2006 14:00
frole31 04, Eventlog Sy stemWARNING, HARD, 1,10 newy events for the last 30 mnl

charly W, EventLog System, O HARD; 1, 0K: no nevw events for the last 30 mn
FRCLS1 704, Evertlog System OH; HARD, 1, 0K: no newy events far the last 30 mn

(@l [25-07-2006 14:24.09] SERVICE ALERT: frols3104; SystemLoadl. CPLLOK, HARD1; CPU Load OK (1mn: 5%) (10mn: 23%)
o [25-07-2006 14:22:19]) SERVICE ALERT: frelsG260; SystemLoad CPU; CRITICAL HARD:1 :CPU Utiization: 100% (1mn), 83%

(5mn), 44% (15mn) CRITICAL

[25-07-2006 1 4:22:08] SERVICE ALERT: frols1 704; Eventlog System; OH;HARD: 1, 0K no new events for the last 300 mn
@ [25-07-2006 14:19:55] SERVICE ALERT: frols3104; Eventlog Security, O, HARD; 1; OK: no new events for the last 30 mn
1!) [25-07-2006 14:13:09] SERVICE ALERT: frcls3104; SystemLoad CPUWWARNIMG HARD, 1, CPU Load HIGH (1m: BE%) (10m:

18%:)

(@l [25-07-2006 14:07:15] SERVICE ALERT: frols6260;FileSystems. AILOKHARD; 1,DISKS OK: alldisks less than 80% utized.
o [25-07-2006 14:02:15] SERVICE ALERT: frels5260;FileSystems Al CRITICAL HARD; 1: DISK CRITICAL: [ inedia/cdrecarder )

mare than 0% wutilized.

1!) [25-07-2006 1 4:01:58] SERVICE ALERT: charly W, Evertlog System WARNING, HARD; 1;1 new everts for the last 30 mnl

July 25, 2006 13:00

1!) [25-07-2006 13:54:25]) SERVICE ALERT: FRCLS1704; EventLog. System WARNMINGHARD; 1,1 new evernts for the last 30 mol
1!) [25-07-2006 13:52:08] SERVICE ALERT: frolst 704, Eventlog Sy stemWARMING;HARD: 1,1 nevy events for the last 30 mnl
@ [25-07-2006 13:31:59] SERVICE ALERT: charly W, EvertLog System OH; HARD, 1, 0K: no newy events for the last 30 mn

1!) [25-07-2006 1 3:30:08] SERVICE ALERT: frols3104;Eventlog Security WARNING, HARD;1; 20 nevy everts for the last 30 mnl
1!) [25-07-2006 1 3:01:58] SERVICE ALERT: charly W, Evertlog System WARNING, HARD; 11 new everts for the last 30 mnl

July 25, 2006 12:00

Figure 3-29 Monitoring Server Log

Bull System Manager Log shows all the events logged by the monitoring process:

The screen is divided into two parts:

The top part of the screen allows you to modify the display according to a set of

criteria:

Event Log selection

Earliest Entries First

By default, only the entries recorded in the current log
are displayed. To see older entries, you can select an
archived log.

Allows you to select the order of entries displayed. By
default, the most recent entries are displayed first.

The bottom part of the screen displays logged events:

—  Host and Service alerts

—  Alert notifications
—  Alert acknowledgeme
—  New comments

nts

—  Configuration information messages

—  Miscellaneous.
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3.42.8

58

Control

When you launch the Control screen from the Hosts or Hostgroups root nodes, Monitoring
Server information is displayed. You also have a launching point for sending commands to
the monitoring server and links to Detailed Information.

Monitoring server information Commands
Process Status (9]¢ gﬁ: Stop the Monitaring server
Program Start Time 25-07-2006 09:44:55 1“"- Restart the Monitoring serwer
Totsl Running Time Ocd 2k 4m 10z x Stop executing service checks
La=t External Command Check 25-07-2006 11:48:55 x Stop executing host checks
Las=t Log File Ratation Pi, x Dizahle notifications
Montaring server (Magios) PID 2260 x Dizahle event handlers
Motifications Enabled? YES

) ) Detailed Information
Service Checks Being Executed? YE=

ﬁ Petformance Information

Host Checks Being Executed? YES

[ sScheduling Queue
Event Handlers Enabled? YE=

Figure 3-30 Monitoring Server commands

Monitoring Server Information

Gives general information about the Nagios monitoring process.

Commands

Allows you to perform actions on monitoring functions.

When you click a command, you are prompted to confirm by clicking Commit in the
confirmation page. The command is posted for immediate execution by the Monitoring
Server.

Note

Process Commands require Administrator rights.

Detailed Information
Allows you to access detailed information about the performance and scheduling queue.

Performance Information gives statistical information about the Nagios monitoring process
for each kind of check:

—  the minimum, maximum and average time recorded for check execution

—  the minimum, maximum and average time recorded for check latency (check

delay time due to monitoring server overload)

—  the current number of active service checks

—  the current number of passive service checks

—  the current number of active host checks.
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Performance Information

Time Frame

Last Updated: 25-07-2006 11:.52:18
Updated every 120 seconds

Checks Completed

==1 minute 16 (21 .6%)
== 5 minutes T1095.9%)
== 15 minutes T4 (100.0%
Active Service Checks ¢ )
=="1 hour T4 (100.0%)
# Total Services: £ Since program start 74 (100,0%)
# Active Services: 74
# Disahled Services 0 Metric Min. Max. Average
Check Execution Time =1 zec 32zec 1.635sec
Check Latency =1 sec 2sec 0000 =sec
Percent State Change 0.00% 2480% 4.24%
Time Frame Checks Completed
==1 minute 0(0.0%)
<=4 minutes 0(0.0%)
Passive Service Checks <= 15 minutes 0 (0.0%)
# Total Services: 79 ==1 hour 0(0.0%)
# Pazsive Services: 3 Since program start 000.0%)
Metric Min. Max. Average
Percent State Change 000% 0.00% 0.00%
Time Frame Checks Completed
== 1 minute: B (37.5%]
== 5 minutes: 9(56.29%)
== 15 minutes: 9(56.2%
Active Host Checks ¢ )
<=1 hour: 11 (B8.8%)
# Total Hosts: 16 Since program start: 15 (93.8%)
# Active Checked Hosts: 16
# Mot Checked Hosts: 0 Metric

Check Execution Time:

Check Latency:

Percent State Change:

Min. Max. Average
000 zec 084 sec 0.252 sec

0.00 zec 0.00 sec 0,000 sec
000%  1013% 1.02%
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Scheduling Queue displays the time of the last and next check for each monitored host or

service.
Check Scheduling Queus ndated sary 120 sacands
Host Senvice Last Check Next Check Active Checks
chiatly W Evertl og.System 29-07-2006 14:16:90  23-07-2006 14:21:350 EMABLED
charly L Systemload Memary 25-07-2006 14:16:50 25-07-2006 14:21:50 ErABLED
chiatly W Systemload Memary 29-07-2006 14:16:91  23-07-2006 14:21:31 EMABLED
frelsl 704 Systemnl oad Memary 25-07-2006 14:16:558 25-07-2006 14:21:53 EMABLED
frls 704 Ewentl og.Systen 23-07-2006 1416:55 25-07-200614:21:58 EMABLED
frols3104 LogicalDisks Al 25-07-2006 141702 23-07-2006 14:22:02 EMABLED
[WixE PIRG 25-07-2006 141708 25-07-2006 14:22:08 EMABLED
frolsB2E0 Systemnload CPL 29-07-2006 141708 23-07-2006 14:22:08 EMABLED
frelsB2E0 FileSystems Al 25-07-2006 141708 25-07-2006 14:22:08 EMABLED
hlace1 Hardvware Heatth 25-07-2006 14:21:09  25-07-2006 14:22:09 EMABLED
nzmaster PIMG 25-07-2006 141718 25-07-200614:22:18 EMABLED
nsmaster-rme RMC PorwverStatus 25-07-2006 141719 25-07-2006 14:22:19 EMABLED
FRCL=1704 Evertl og.Application 25-07-2006 141719 23-07-2006 14:22:149 EMABLED
charly W Hardvware Heafth 25-07-200614:21:24 25-07-2006 14:22:24 EMABLED
hlade2 Hardvware Heaftth 25-07-2006 14:21:24  25-07-2006 14:22:24 EMABLED

Figure 3-32 Scheduling Information

When you launch the Control screen from a host or a service, host or service monitoring
information and host or service comments are displayed. You can also enable/disable
notifications, enable or disable service checks.

Host monitoring information Host Commands

Last Status Check 25-07-2006 034316 x Dizable checks of this host

x Dizable notifications for this host

Last State Change: 25-07-2006 0204910

T —— NI, x Dizable notifications for all services on this host
azt Ho itication

w Enahble notifications for all services on this host

Current Matification Mumber 0

chedule & Check Of All Services On This Host

Host Checks EMNABLED

x Dizable checks of all services on thiz host
Host Motificstions ENABLED w Enable checks of all services on this host
Evert Handler DISABLED w Enable evert handler for this host

g} Add & commernt -‘:, Delete all commerits

Host Comments

Time Author Comment

Thiz host has no comments associated with i

ID Persistent Type

Figure 3-33 Monitoring Host commands
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Host/Service Monitoring Information

Gives general information about host or service monitoring.

Host/Service Comments

Displays the comments associated to the host or service and allows you to add or delete
comments.

Host/Service Commands
Enables actions on monitoring functions.
When you click a command, you are prompted to confirm by clicking Commit in the

confirmation page. The command is posted for immediate execution by the Monitoring
Server.

Note  Commands require Administrator rights.

3.4.3 Reporting Information

The following table lists the available information types and associated supervision scope.

Information Type Supervision Scope
Alert History Root nodes of Hosts and Hostgroups views (Tree)
Hostgroup,
Host,
Service.
Nofifications Root nodes of Hosts and Hostgroups views (Tree),
Hostgroup,
Host,
Service.

Avaibility ::OO: nodes of Hosts and Hostgroups views (Tree),
ostgroup,

Host,

Service.

Status Trends Root nodes of Hosts and Hostgroups views (Tree)
Host,

Service

Indicator Trends Root nodes of Hosts and Hostgroups views (Tree)
Hostgroup,

Host,

Service.
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3.4.3.1 Alert History

This screen displays host and service alerts according to the selected context. For example,
when this screen is called from a Hostgroup, only the Alerts related to the hosts contained
in the selected Hostgroup are given, as displayed below. Information about Alert History is
detailed in Looking in the Past with Alert History, on page 14.

g [Hs_Master | Alenstype |Hostsand Services =] T Mot acknowledged
& [=alLHosTS = E Aot Al =l kst
O I“."-\LL SERVICES * ;I Report Periad |La$t?Days ;!
I ax e ms: IT Apply I Reset |
Matching Alerts Date/Time Server: 28-04-2005 14:40:17
Time Host Sendice State  Count Information
28-04-2005 130718 frolz5208 Eventl oo.Lpplication 0K 1 Ok no nesy events for the last 30 mn
28-04-2005 124118 frols5208 Systemload CPU 0K 1 CPU Load QK (1mn: 46%) (10mn: 50%)
T i s e
26042005 12:31:22  frels5208 Systemload CPL  BUCGIIEN 1 gfi;g:‘mgg‘aggégag%"%“ BRSO
26.04-200512.26:23  frols5203 Systeml oad CPU 1 gfouc'ég:“;mg'agini;gggﬁém Dt Al
26-04-2005 122222 frels5208 Eventl og.Application |2 1 28 newy events for the last 30 mnl
28-04-2003 12:21:23  frels5208 Systeml oad.CPU Al 1 CPU Load HIGH (1m: B6%) (10m: 27%)
26-04-2005 120258 frels5208 Eventl on.Security 1 Ok no newr events for the last 30 mn
26-04-200511:33.02  frels5208 Eventl og.Security 1 4 newy everts for the last 30 mnl
27-04-2005 16:21:29  frels5208 Eventl o System 1 Ok no newr events for the last 30 mn
27-04-2005 16:20:06  frels5208 Eventl o Application DK 1 Ok no newr events for the last 30 mn
27-04-2005 155137 frels5208 Eventl o System AL 1 1 new everts for the last 30 mnl
27-04-2005 154502 frels5208 Eventl og.Application |25 1 2 new everts for the last 30 mnl
27-04-2005 144538 frels5208 Eventl on.Security DK 1 Ok no newr events for the last 30 mn

Figure 3-34 Alert History screen - example
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3.4.3.2

Notifications

This screen displays notifications that have been sent to various contacts, according to the
selected context. When this screen is called from a Root node, it reports all notifications for
all the resources declared in the Bull System Manager application, as displayed below.

Archives

to
FPresent..

Matching Notifications
Time Host

28-04-2005 15000258 klade2 I,

Log File Havigation
Sun Apr24 00:00:00 RDT 2005

25-04-2005 150237 frols1 704 EventLog.Application BEERIESE manager  notify-by-email

28-04-200515:02:16  froleB260  Systemboad CPU

rlotification e
i | Al notifications =]

Earliest Entries
Firzt: r

Apply |

Senvice Type Contact Command Information

2 newy
events for
the last 30
mn!

CPLU
LHilization:
E8% (1mm),
T9% (5mn),
B50% (15mn)
CRITICAL

SRR manager  notify-by-emsil

PING
CRITICAL -
Packet lozs =
100%

Eﬂ:',:,,,,TJ manager  host-notify-by-emai

(displayed notifications: 33

Figure 3-35 Notifications screen - example

The screen is divided into two parts:

e The top part of the screen allows you to modify the notifications reported, according to

a set of criteria:

Log File

Notification Level

Earliest Entries First

By default, only the notifications recorded in the current log
are displayed.

To see older notifications, you can select an archived log.
Allows you to select the type of Notifications displayed
(Service notifications, Host notifications Host Dow, Service
Critical,...).

By default, all notifications are displayed.

Allows you to select the order of notifications displayed.

By default, the most recent notifications are displayed first.

e The bottom part of the screen contains matching notification information according to
the context and the criteria set in the top part of the screen.

Notifications and information about these notifications (Time, Type, Notified Contacts ...)

are displayed according to the
of the notification.

criteria previously set. Type information reflects the severity
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3.43.3
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Availability

This screen reports on the availability of hosts and services over a user-specified period of
time. When called from a root node, it reports the availability summary for each host
declared in the Bull System Manager application. When called from a Host context, the
report will be more detailed as displayed below.

Repott Period: | Thiz Month __-J Apply |

From 01-04-2003 00:00:00 to 25-04-2005 15:04:10 (duration: 27d 15h 4m 10s)

Host State Breakdowns

‘ L TimeUp % Time Down % Time Unreachahle % Time Undetermined
7381 0.00% 0.03%

Services State Breakdowns

i 1 Time % Time % Time % Time % Time

0K YWarning Unknown Critical Undetermined
Hardware Health | 99.92% 0.00% 0.00% 0.04%
PING TaTa% 0.00% 0.04%
Event Host Log Entries [ Wiew full log entries ]
Start Time End Time Duration Type Information

30-03-2003 171008 01-04-2005 092145 1d16h11m 40z | HOSTUR (Host azzumed to he up)
01-04-20035 092525  01-04-2005 09:235:28 0Od Oh Om O= HOET LR (Host azsumed to be up)
01-04-2003 092526 01-04-2005 15:00:05 O 8h 34m 37= HOET UP - (Host assumed to be up)
01-04-2003 18:06:03  01-04-2003 18:06:03 0d Oh Om 0= HOST Lp (Host azsumed to be up)

01-04-2005 18:06:03  01-04-2003 20:11:39  0d 2k 5in 36s HOSTUP | (Host assumed to be up)

PING CRITICAL - Packet loss =

01-04-2003 20:11:99  01-04-2003 20:11:59  0d Oh Om 0= 100%

Figure 3-36 Availability screen - example

The screen is divided into two parts:

e The top part allows you to choose the period over which the report is built (Report
Period selection box). The default period is the last 24 hours.

e The bottom part displays reporting information, according to the context and the report

period.
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The following information is reported:

Host State Breakdowns or  Represents the percent of time spent by the host or service in

Service State Breakdowns  €ach of its possible states.
Note:
Time Unknown is reported when the monitoring server cannot
obtain information about the service (because, for instance, the
host is down, or the monitoring agent is not running on the
target).
Time Undetermined is reported when no information was
collected, mainly because the monitoring server was not
running.

Services State Breakdowns  This information is available if the report is asked for a host.
Availability report for all the services of the host.

Host Log Entries or List of all the Nagios events logged for the host or service during

Service Log Entries the chosen period.

3.4.3.4 Status Trends

This screen displays a graph of host or service states over an arbitrary period of time, as
displayed below.

Repart Period: I Last 24 Hours ;I Apply |

From 27-04-2005 15:13:57 to 25-04-2005 15:13:57 (duration: 1d Oh Om 0s)

Chronology

Ok TR
Urikncr
Critical

Indeterminate

w i) 'y} ['e Ty o
) k=l ey E ) Ly
2 g 2 g 2 2
od ~J (2] LY I N | (2]
F~ Lor ] L L-=2 -~ ] r~
o e} o oo [Ty
[ar] =) o =+ =t o
-— — L3r ] Ly N | -
uwr = L] = W u
- - < oo -
- I~ o o 00 o
[ ] o~ (] LRt ¥ | ol
e - i A [==
o = -5 =~ ==
T <L I I I T
- o - o = o
[} L o il .
= = = | amatc: =
Availability

U Time OK % Tirme Unknown Iz Time Critical % Time Indeterminate
| 0.00% 0.00%

Figure 17.  Status Trends on a Service
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3.4.3.5

3.4.3.6
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The screen is divided into two parts:

e The top part allows you to select the period for which the report is built (Report Period
selection box). The default period is the last 24 hours.

e The bottom part displays information, according to the context and the selected report
period.

The following information is reported:

Chronology Represents the evolution of the host or service status over the selected
time period.

Availability Represents the percent of time spent in each state for the host or
service.

Indicator Trends

The Indicator Trends screen lists the available indicator reports defined for a given
resource, as displayed below.

Information about how to visualize reports associated with these indicators is detailed in
Reports, on page 84.

To display a report, click on an indicator report.

Indicator reports

Indicator report Collect mode Source
cpuload MEM_monitaring SystembLoad CPU
inoctets snmp A361.21221101
outoctets SNME A36121221161

udpincount Snmp A361214710
ydpoutcournt Snmp J3E6124740

Figure 3-37 Indicator Trends on a Host

Inventory Information

The Inventory menu is divided into two submenus: Platform and Operating System.

Platform Information

These screens are available for Host or Service supervision. Information levels vary to OS
and host type.

Inventory Information

This information is OS-dependent and is only available for hosts with Windows or Linux
Operating Systems.

e For Windows hosts, this screen displays the following information:
—  Computer Information
—  Processors Information
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—  Physical Memory Information
- Cache Memory Information
-~ Non-Storage Devices Information.

Computer Information

Hame : FRCLS5208
Domain : WIORKGROUR
Model : ExpressS500/TWE00
Manufacturer : MEC

Physical Memory : 1023 Mbytes

Processors Information

Id Hame Clock Speed Address Width

CPUO  Intel(R) Pentium(R) 4 CPU 2.40GHZ 2411 MHz 32 hits

Physical Memory Information

Installed Banks in Memory Array 1: max capacity 2.0 Gintes

Bank Ho Bank Label Installed Size Memory Form
1 BanklH 1.0 Ghytes Colbathal
2 = i =

Cache Memory Information

1D Level Az sociativity Cache Speed In=talled Size
Cache Memory O 3 Unknowen - 20 Khytes

Status

CPU Enabled

Memory Type
Unknown

Max Cache Size
20 Khytes

Figure 3-38 Windows Inventory information — example

e For Linux hosts, this screen displays the following information:

—  Hardware Information
-  Memory Usage.
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Hardware Information

Processor(s) : 1

Model : Pentium Il (Copperming)
Chip MHz : 2000 Mhz

Cache : 2596 KB

PCl Devices :
PCl device 1166
PCl device 1166
PCl device 1002
PCl device 3036

Internal PCI Devices : PCl device 102b
PCl device 1166
Pl device 1166
PCl device 5005
PCl device 9005

IDE Devices : hda : CRD-34848 (0.00 KB

MEC GEMI 2R2-GFCNE (Proceszor)

SEAGATE ST391 73WC (Direct-Access)
SCSI1 Devices :
SEAGATE ST39204LC (Direct-Access)

SEAGATE ST38204LC (Dirgct-Access)

Memory Usage

Type Percent Used Free Used Size
Physical Memory 5% E.24 MB 497 39 MB 503 64 MB
S 0% 246.62 MB 247 mMB 549.09 MB

Figure 3-39 Linux Inventory information - example

Storage Information

This information is OS-dependent and is only available for hosts with Windows or Linux
Operating Systems.

Storage Devices Information
[1] Model Interface Type Status Capacity
Floppy Drive Floppy disk drive . Qi B
COROMDrive SAMSUNG DVD-ROM SD-616T - Ok =
DiskDrive 0 ST34001 64 IDE Ok 373 Ghytes

Figure 3-40 Windows Storage information - example

FRU Information

This information is only available for Express 5800 and NovaScale 3000, 4000, 5000
and 6000 series hosts.
For details about the information displayed, refer to Chapter 4.

68 BSM 1.0 - User's Guide



3.43.7

Sensor Information

This information is only available for Express 5800 and NovaScale 3000 and 4000 series
hosts.
For details about the information displayed, refer to Chapter 4.

SEL Information

This information is only available for Express 5800 and NovaScale 3000, 4000, 5000
and 6000 series hosts.
For details about the information displayed, refer to Chapter 4.

Operating System Information

These screens are available for Host or Service supervision. Information levels vary
according to OS and host type.

Windows Information

The Windows System screen displays the following information:
-~ OS Version Information
-~ OS Computer Information
—  OS Installation Information

05 Version Information

05 Hame : Microsoft(R) Windows(R) Server 2003, Enterprize Edition

Yersion : 5.2.3790

Service Pack :

Language : Englizh (United States)
Serial Humber : B8713-337-4219131-42520
Registered User : MEMaster RED
Organization : Bull 5.4

0S Computer Information

Computer Hame : FRCLS5203

Status : Ok

Last BootUp Time : 2005/04M 4 15:45: 51
Humber Of Processes : a7

Humber OF Users : 4

05 Installation Information

Install Date : 20030111 02:01:30
System Device : ‘DeviceiHarddizk Y olume
System Directory : MDY S sy stem32
Boot Device : \DeviceHarddisk olume

Figure 3-41 Windows System screen - example
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The Windows Process screen displays running processes:

Processes Information
Hame PID Executable Path Creation Date  Priority CPU Time Virtual Memory Used Threads
syslon e 0 - 0 3062605 DKk 1
System 4 5 2 8 012613 0Kk 55
smss exe 432 : Zooiis 11 000002 184 Kb 3
carssexs 180 CIMNDOWS sy stemaZiosrss exe 25'g54’g:"1”24 13 011528 1840Kh 15
wirlogon exe S04 CIMINDOWS lsystema2iwiniogon exe 25'g54’g:"1”34 13 000304 7044 Kb 17
servicesexe 548 CUAMNDOWS sy stem32iservices exe 25'g54’g:"1”54 9 002311 7484 Kh 2
Isass exe 60 CUIMNDONS system32isass exe 25'g54’g:"1”54 9 005641 916 Kh 36
svchostexe 738 CHMNDOWS sy stem32isvehast exe 2%54%11%4 8 000326 1152 Kb 1"
svchostexe 795 CHMNDOWS Systema2iavehost exe 2%54%11%4 8 000416 2252 Kh 2
svchostexe 943 CHMNDOWS sy stem32isvehast exe 25'?%’%‘{;“ 8 000126 3644 Kh E]
nemA

Figure 3-42 Windows Process screen - example

The Windows Users screen displays users information:

Users Information

Hame Domain Description Status
Adminiztrator FRCLS5203 Buitt-in accourt for administering the computeridomain Ol
Guest FRCLS5203 Buitt-in accourt for guest sccess to the computeridomain Cegraded
IUSR_FRCLES205 FRCLE5208 Built-in account for anonymous access to Internet Information Services Ol
Buitt-in sccount for Internet Information Services to start out of process
AN _FRCLS5208 FRCLS5208 applications Ok,
nsmaster FRCLS5208 nstmEster QK
SUPPORT_385945a0 FRCLE5203 Thiz i & vendor's account for the Help and Support Service Degraded
_ wmwware_user_ FRCLSS205 Whiware User Ok
Figure 3-43 Windows Users screen - example
The Windows Products screen displays installed products:
Products Information
Hame Yendor Version Install Date
Adobe Reader 7.0 Adobe Systems Incorporated 7.0ao 2005017 4 00:00:00
Java 2 Rurtime Environmert, S5E w1 .4.2_03 Sun Microsystemns, Inc. 1.4.2 03 200441 2720 00:00:00

Figure 3-44 Windows Products screen - example

Note  On servers running Windows Operating System, only products installed using a .MSl file
are displayed.
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The Windows Logical Disks screen displays information about logical disks:

Logical Disks Information

Drive Description VYolume Hame Provider Hame Capacity Used Space Free Space
A 3172 Inch Floppy Drive - - - - -
i Local Fixed Dizk - 18.5 Ghytes E¥ % B 5 Ghytes
[0} CO-ROM Disc - - - - -
X Metwork Connection livraizon Wircle2681 Yivraizon 9.4 Ghytes 88 % 1.2 Ghytes
A Metwork Connection  PambLife: 39 GB  WamwebkSecurity 5.9 Ghytes 3% 58 Ghytes
7 Metwark Connectian Factory whottaliz\factory  17.0 Ghytes 45 % 9.2 Ghytes
Figure 3-45 Windows Logical Disks screen - example
The Windows Services screen displays services information:
Services Information
Display Hame State  Has Been Started ? Start Mode Executable Path Action if Startup Failure Account
Slerter Stopped FALSE Disabled CHMEDRG By vthnste e ok Hormal NT AUTHORITY YL ocalService
Agfe"\?f;'\?ggf\};gg Stopped FALSE Maral CIMNDOWS Sy stem32laly exe Narmal NT AUTHORITY YLocalSsrvice
Mz%ﬂg::g:d Stopped FALSE Manual CAMNDOWS\system32\svchost exe -k netsves Mormal LocalSystem
Windows Audio | Stopped FALSE Disabled COANDOWSISystem32isvchost exe -k netsves Mormal LocalSystem
Background
Tranlrsﬂf'zﬂgggvice Running TRUE Manual CUMMDCYYShsy stem32isvchost exe -k netsves Mormal LocalSystem
%Drgausteerr Running TRLE Auto CWMNDOW S ystem32iavchost exe -k netsves Mormal LocalSystem
Indexing Service | Stopped FALSE Dizahled CIMDOWS ey stem32icisve exe Mormal LocalSystem
CligBaak Stopperd FaLSE Disabled CIUMNDOWS sy stem32icipsry exe Narmal LocalSystem
Cobmicion” |Soeeed|  FALSE Maruil AR 1 FOonT 1SR D00 T8 Nermal LocalSysten
Crysp;ro\%rcighic Running TRLE Auto CWMNDOW S ystem32iavchost exe -k netsves Mormal LocalSystem

Figure 3-46 Windows Services screen - example

3.4.3.8 Linux Information

The Linux System screen displays the following information:
- System Information
- Network Information

-~ Memory Usage Information

—  Mounted Filesystems Information
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System
HostHame :
05:
Uptime :

Load Average :

Network

Interface

eth0
=it0

Memory Usage

Type
Phyzical Metmory

Swyap

Mounted Filesystems
Partition

fdevizdal (ext3)

Idevizdal (ext3)

none (Rroc)

none (sysfs)

none (tmpfs)

none (devpts)

frolsf260 (1291582633 )

Linwe 2.6.9-1 645_EL

80 days, 2 hours, 7 minutes

1.09 (1 min), 0.91 (5 min), 0.85 (15 min)

2.0 GB
249GB
0.00 kB

Percent Used
9%
0%

Mount Point
Moot
!
haroc
fsys
fdesishm

fdevipts

TX
201 GB
166 GB
0.00 kB

Free
36T MBE
546.62 MB

Percent Used

9%
30%

0%

1009

Used
499 96 MB

247 MB

Free
8525 MB
514 0GB
0.00 KB
0.00 KB
251 .82mB
0.00 KB

Err/Drop
Size
503.64 MB
544903 MB
Used Size

537 MB 9572MB
216 GH TE9GH
0.00 KB 0.00 KB
0.00 KB 0.00 KB
0.00 KB 251 62 MB
0.00 KB 0.00 KB

Figure 3-47 Linux System screen - example

The Linux Process screen displays processes sorted by PID, User, Memory Usage or CPU

Usage.

The following example shows processes sorted by Memory Usage. You can select the
required sort option by clicking the corresponding link.
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Command

Jusrhinfantsd -F 10 -5 4096 -= B0 -m artsmessage - drkongi .
eqgcups --sm-config-prefix feggoups-SgSheys -—sm-client-id 1 ..

kdeinit: konsale -session 10109a89552000111233581 100000015947 ..

koeinit: kwin -zession 10109a895a20001 1081 231 5500000036:52000 ...

Display: PID User Memory CPU Search
Real memory: 515724 kBtaotal f 202216 kB free Swap space: S62264 kBtotal f 5597326 KB free
Process D  Owner Size
15711 root 56568 kB Jusrl 1 REAING (0 —audit O -suth Sardgdmet 0 Xauth -nolist
27654 roat 43936 kB
27687 roat 41656 kB
27659 roat 35116 KB kdeinit: knatify
27676 root 32116 KB kdeinit: kicker
28473 root 32076 kB kdeinit: konsole
27EE9 root 30924 kB Jusrhindoython jusrhinihn-applet-gui --sm-config-prefiz § ..
27692 roat 30540 kB
2VEEY root 28664 kKB kdeinit: kdeskiop
27EES roat 28736 kB
27Es0 root 27932 kB kdeinit: kio_file file fmpksocket-rootklauncheryYWWscga sla
27685 roat 27520 kB kdeinit: khotkeys
27664 root 27360 KB kdeinit: kemzerver
27E3T root 27268 kB kdeinit: klauncher
10916 root 27096 KB Jusrhindkdeskiop_lock
2732 root 26464 kKB kdeinit: Running...
10817 root 25604 KB fuzrhinkbanner kssz -root
27E35 root 25100 kB kdeinit: dcopserver --nosid

Figure 3-48 Linux Process screen - example

The Linux Users screen displays user information:

Local Users

U=zername Uzer ID Real name Home directory Shell
aclm 3 adm Searfacm Izhinfmologin
apache 48 Spache FEE ey fzhinfnologin
kin 1 kin Jhin Izhin/nologin
claemon 2 daemaon Izhin fzhinmologin
dhus &1 System message bus ! f=hinfmologin
ftp 14 FTP Uszer Feariftp f=hinfnalogin
games 12 games Justigames Izhinmologin
gam 42 Fearigdm f=hindmologin
gopher 13 gopher Fearigopher f=hinfnalogin
haldaemon [=t2] HAL daemon i Izhinmologin
bt 7 hatt fzhin Izhintalt
Ip 4 Ip Fearfspoolipd f=hinfnalogin
mizil a mail Mearfzpoolimail Izhinmologin
miilnll 47 Fearfzpoalimogueue Izhinmologin
netdumgp 34 Metwork Crash Dump user Ffearicrash hinkash
newys 9 nNEvys Jetcinews
nfznokbocdy 65534 Anonymous NFS User Fearfibinfs Izhinmologin

Figure 3-49 Linux Users screen - example

The Linux RPM Products screen allows you to display installed packages by using a search

tool or by browsing the package tree.
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Installed Packages

|Searu:h For Package: I ISNMF‘ Fackage Tree

Figure 31.  Linux RMP Products search screen - example

For example, if you enter SNMP in the search field and then click Search For Package, the
following display appears:

Packages matching smmp

|Package |Class |Descriptiun

net-snmp 5.1.2- |System A collection of SNMP protocol tools and
11 Environment/Dasmons libraries.

;?ﬁm Development/Libraries The MET-SMMP runtime libraries.

net-snmp-utils Metwork management utilities using

5.12-11 EplicaaeSyCLeh SNMP, from the NET-SNMP project.
dphBQ-geigmg Divela et LangiAges A rmodule for PHP applications that

s query SHMP-managed devices.

Feturn to module inde:

Figure 3-50 Linux RPM Products - example

The Linux System Logs screen displays available logs and allows you to view them.

Log destination Active ? Messages selected

Figure 3-51 Linux System Logs screen - example

3.4.4 Operations Menu

The Operations menu allows an Administrator to take a remote control of a platform or
Operating System.

This menu is only available to Administrators and is divided into several potential
submenus: Platform, Operating System, Consolidation, Applications and Storage.
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3.4.4.1

3.4.4.2

Platform Menu

These menus are available for Hardware Manager and Host (and services) with a
dedicated hardware manager.

Power Control

Allows the administrator to manage power control through the Bull System Manager

Hardware Management application.

Manager GUI

Allows you to launch the appropriate hardware manager:

PAM for NovaScale 5000 and 6000 series

ISM for NovaScale 4000 series

CMM for NovaScale Blade series

RMC or ARMC, SIMSO+ for Intel based computers.

Any other manager that can be accessed via a URL.

Operating system Menu

These menus are available for Host or Service supervision. Information levels vary
according to OS and host type.

Remote Operation Menu for Windows

... >VYNC Viewer Starts VNC viewer to connect to this host.
.. >MMC

.. >Remote Desktop

Remote Operation Menu for Linux

.. >SSH Launches SSH to connect to this host.
Following items Open a Webmin page:

.. >Shell to execute a Unix shell command.

.. > FileSystem to manage disk and network file systems.
.. > Processes fo manage running processes.

.. > Users to manage Users and Groups.

.. > Password to manage passwords.

..-> RPM to manage software packages.

.. > System Logs to manage system logs.

.. > NetConfig to manage network configuration.

Note

SSH command calls a Console local SSH client. This command runs only on Linux console

machines.
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3.4.4.3 Storage Menu

This menu is available for Storage Manager, Host or Service supervision.

From this menu, you can call the storage manager GUI.

3.4.44 Consolidation Menu

This menu is available for Host supervision.

From this menu, you can call specific management tools for virtualization and/or
consolidation (generally, these items come with specific Server Add-ons).

3.4.4.5 Application Menu

This menu is available for Host supervision.

From this menu, you can call specific management tools for specific Bull applicative
framework and/or applications (generally, these items come with specific Server Add-ons).
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Chapter 4. Using Bull System Manager Console Applications

4.1 Bull System Manager Hardware Management Application

The Bull System Manager Remote Hardware Management Application provides the same
look and feel for hardware operations independently of the target machine type.

This application manages Power Control, and displays FRUs, Sensors and System Event
Logs for Express 5800 and NovaScale 4000, 5000, 6000 or Blade series servers.
There are two ways to start the application:

e Launch the Hardware Management Application from the application bar

e Activate the Hardware > Remote Control item in the Console Management Tree host
menu.

Host Selection Action Pane Display Pane

2/ frclsB004.frcl bull.fr - Bull System Manager 1.0.2 - Remaob - Hardis nagement =101 =]

n BSM Remote Hardware |"u"'.|.'1|'|.|!'J!:]-:'_-rn.;;_;m". Reload Q Help
~select a hogt- =

Host propertie

Bull System

l"r\-"'q'.Q

Figure 4-1 Remote Hardware Management screen
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4.1.1

4.1.1.1
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Bull System Manager Remote Hardware Management comprises three functional parts:
Host Selection Pane & Current Selected Host Pane
Allows you to select the current host from all the Express 5800 and

NovaScale 4000, 5000, 6000 or Blade servers declared in the Bull
System Manager configuration and displays it.

Action Pane Displays the hardware operations that can be executed.

Display Pane Displays parameter forms, messages and command results.

Host Selection

Hardware commands only apply to the selected host. The selected host name is displayed
in the Current Selected Host Pane.

The application is launched contextually from the Current Selected Host in the Console
Management Tree.

You can select another host from the list of available hosts in the Host Selection Pane.

When a host is selected, the application reads Bull System Manager configuration files to
get host properties.

Host Properties

You can display selected host properties by clicking View:

Ml HOST: charlydL

Host Description

Mame charly4L

Descrigtion Avtomatically created for the NS S005 platform.
Model MS 5005 series

0= Lirw farmily

Rletweark Mame 172.31.50.80

Hardware Management

PAM Dormain D comi
P&M Marme charly4_PA
Metvweork Mame 172.31.80.50

Figure 42 NovaScale 5000 Server host properties - example
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Host properties differ according to host type, as shown in the following tables:

Name

Name of the current selected host to which commands are applied.

Model

Host model.

Network Name

Current selected host local network name or IP address.

Operating System

Operating system type (Windows, Linux or any).

Out-Of-Band information

Network name

network name

Table 4-1. NovaScale 4000 Server host properties

Name

Name of the current selected host to which commands are applied.

Model

Host model.

Operating System

Operating system type (Windows, Linux or any)

Network name

Current selected host local network name or IP address

Hardware Management

PAM Domain ID

Current selected host domain name

PAM Name

PAM Manager name.

Network Name

Local network name or IP address of the PAP server managing the
current selected host.

Table 4-2. NovaScale 5000 or 6000 Server host properties

Name

Name of the current selected host to which commands are applied..

model

Host model

Network Name

Current selected host local network name or IP address.

Operating System

Operating system type (Windows, Linux or any).

Out-Of-Band information

Network Name

RMC network name.

Table 4-3. Express 5800 Server host properties

These values always correspond with those found in the Bull System Manager

Configuration.
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4.1.2

4.1.2.1

4.1.2.2

80

Commands

Note  All commands are applicable to the Current Selected Host.
Prerequisites
NovaScale 3000 Servers
The BMC (Baseboard Management Controller) on the managed host must be configured
for remote-control over LAN.
NovaScale 4000 Servers
An SMU (System Maintenance Utility) user must be declared for the managed host via the
ISM (Intel Server Management) software delivered with NovaScale 4000 servers. User
authentication must be declared in the Bull System Manager Configuration.
NovaScale 5000 and 6000 Servers
Bull System Manager Hardware commands are sent to the PAP server for execution. The
only prerequisite is that the targeted host is managed by an operational PAP unit accessible
from the Bull System Manager server.
NovaScale Blade Servers
Bull System Manager server must be declared as SNMP Manager in the CMM
configuration. For details, please refer to the NovaScale Blade Chassis Management
Module Installation and User’s Guide
NS R400/NS T800/Express 5800 Servers
The BMC (Baseboard Management Controller) on the managed host must be configured
for remote-control over LAN. This is done using the Intel SysConfig tool or DOS
configuration tool available on the NEC EXPRESSBUILDER CD-ROM delivered with Express
5800 Series servers.
Command Outputs

A message indicating command failure or acceptance is displayed.

Power Control

As Power Control operations (except Power Status) are executed asynchronously, the output
only indicates if the command is accepted and started. It does not indicate whether the
command has been executed or not.
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[l HOST: nsmaster

Power Status

O nsmaster : Powered OH

Figure 4-3  Power Status output - example

Note  In order for the “power off” command to be taken into account on a remote host running
Windows 2000 / 2003 server, the “Shutdown: Allow system to be shut down without
having to log on” security option must be enabled on the remote host.

You can configure this security setting by opening the appropriate policy and expanding
the console tree as such:

1. Click Start, and then click Run.
2. In the Open box, type gpedit.msc, and then click OK.

3. In the Group Policy window, expand Computer Configuration\Windows
Settings\Security Settings\Local Policies\Security Options\.

4. Set the shutdown security option to “enabled”.

FRU

Click FRU to display the FRUs (Field Replacement Unit).

El HOST: nsmaster

FRUs

FRU Description
[# Buitin FRU device
[+ RMC FRU Device ID: 1
[# Pwr D=tBd FRU Device 1D 2
& Dibdtd 21 SPD Device ID; 4
& DIMMW B1 SPD Device I0: 5
& DIMM 22 SPD Device ID: 6
& Dk B2 SPD Device I0: 7
[# DIMM 23 SPD Device ID: 8
[+ Dimt B3 SPD Device ID: 9
2 DM 24 SPD Device 10 10
_,‘_‘. DIk B4 SPD Device 1D: 11

Figure 4-4  FRU output - example
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SENSOR

Click Sensor to display sensors.

Note  This option is not available for NovaScale 5000, 6000 and Blade series servers.

Ll HOST: nsmaster
Sensors
Twpe ID Status

[+ Yolage Proacessar 1 Woop (Ox10) ak
[+ “oltage Proceszor 2 Yoop (0x11)] =
[+ Yoltage Basehoard 3.3 (0x12) ak
[+ Yoltane Bazeboard 3.3V =B (0x13) ok
[+ Yoltane Bazehoard 5% (0wl 4) ak
[+ “oltage Bazeboard 5%3SB (0x15) ak
[# Yoltage Bazseboard 12% (0x16) ak
[+ Yoltane Bazeboard WBAT (0x171 ok
[+ Yoltane SCSLA Wref 1 (Ox18) ak
[+ “oltage SCELA vref 2 (013 ak
[+ Yoltage SCSLA Vref 3 (0x1a) ak
[+ Yoltane =SB Yref 1 (0x10) ok
[+ Yoltane SCSIB Wref 2 (0x12) ak
[+ “oltage SCEIB Wref 3 (0 d) ak
[+ Tempersture Bazehoard Templ (0x30) ak
[+ Temperature Procezzor 1 Temp (Ox32) ok

Figure 45 SENSOR output - example

SEL/PAM History

Click SEL (Express 5800 and NovaScale R400, T800, 3005, 4000 and Blade Series) or
PAM History (Nova Scale 5000 and 6000 Series) to display the 20 most recent records of
the System Event Log.

You can view records according fo rank, to navigate to next or previous records and to
view the oldest records.

The Clear all SEL entries is used to clear all the System Event Log entries. This functionality
is not present in PAM history.

Note  The Refresh button is only enabled when the most recent records are displayed.
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System Event Log

Rank Record ID Time

00020 0180 0B/20/2007 17:02:53
0o0a 06 OB/2002007 17:01:47
0o01E 0153 0B/20/2007 17:00:07
00017 0144 0B/20/2007 16:53:43
0006 0130 0B/2002007 16:26:10
ooos 014e OB/2002007 14:40:12
ooo014 0103 OB/2002007 141527
00013 0014 0B/2002007 13:24:16
00012 00ed 0B/20/2007 05:07:02
00011 00ec 0B/2002007 00123
00010 00kE 0B/2002007 00:M:A17
00008 00ad 054 952007 14:52:10
00005 0090 06/ 8/2007 19:46:25

RankNumberI ﬁl Top ilil BDlleI

[l HOST: nsmaster

Refresh

Clear all SEL entries

Records fram 00020 to 00004 (the most recent record=)

Sensor Type
System Boat Inttiated (System Init)
System Event (System Event)
Physical Security (Physical Scriy)
Physical Security (Physical Scriy)
Physical Security (Physical Scriy)
System Boot Intiated (Systetn Init)
System Event (System Event)
Physical Security (Physical Scriy)
Physical Security (Physical Scriy)
Physical Security (Physical Scriy)
Physical Security (Physical Scriy)
Physical Security (Physical Scriy)
Physical Security (Physical Scriy)

Num Description

al Initisted by powwer up (D0

87 OEM System boot event (418f1)
05 General Chassis intrusion (4051F)
05 General Chassis intrusion (4051F)
05 General Chassis intrusion (4051F)
al Initisted by powveer up (O0FFFF)

87 OEM System boot event (418f1)
05 General Chassis intrusion (40811
05 General Chassis intrusion (40811
05 General Chassis intrusion (40811
05 General Chassis intrusion (40811
05 General Chassis intrusion (40511
05 General Chassis intrusion (40511

| »

Figure 4-6  SEL output - example

Rank Mumber I ﬁl

PAM history (PAM)
SV Rank Record ID Time

a 2 28281018 030105 22:00:02

@ 28282600 030105 22:00:02

i HOST: pfB-103

ﬂl il}_)l B ottom |

Records from Zto 1 (the most recent records)

Target
Pap

HISTORY _PAMHISTORY

Description
PAM internal error. Please contact the customer
support.

Current history created with PARM revizion :
g§.10.0

Refresh |

Figure 47 PAM History output - example
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4.2  Reports

You can visualize the reports associated with these indicators, as follows:

1. Launch the Bull System Manager Console and click Reports button to display available
reports.

2. Click the required report.

To desplay a repord, click on an indisater report

Indicator reports

Host Name Source
breddeciceicd Systemload. CRU (i)
factary_hwd b4 eriflement Systemload.CRU (i)
bred zhores Systemnload.CRU (six)
frol=5208 cpu frol=52308 Systemboad CPU (windows)

Figure 4-8  Indicator Reports

Each report comprises four graphs:

e Daily

e Weekly
e Monthly
e Yearly
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ifinOctets on frels2703

The statistics were last updated Friday, 15 October 2004 at 11:58

"Daily' Graph (5 Minute Average)

56.0 k __0ct 15 2004 115
o 42,0 k
(1)
£
5oz k
G
5 4.0k

0.0k

4 6 8 10 12 14 16 15 20 22 0 2 4 & & 10

Max 537k Awverage 15960 Current 10040

"Weekly' Graph (30 Minute Average)

12.4 k

9.3 k

6.2 k

octet /zec

3.1k

0.0 k

Thu Fri Sat Sun

Max 121k Awverage 15870 Current 11380

Figure 4-9  Daily and Weekly Report Graphs - example
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4.3  Other Applications

You can launch external applications by clicking the required icon in the Other Tools Pane.
Use the arrows to scroll through the list of applications. As Administrator, you can add
external applications. Please refer to the Administrator’s Guide for details.

Note  The Bull icon gives you direct access to the Bull Support Web Site.

Other
A

v

Figure 4-10 Other applications
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Chapter 5. Categories and Services Reference List

This chapter describes the categories and default services for monitoring Linux, AIX or
Windows systems.

As Administrator, you can change, remove or add categories and services to the
configuration. Please refer to the Administrator’s Guide for details.

Notes e  Other Categories and Services are provided by NovaScale Server Add-Ons. They are
described in the Bull System Manager Server Add-ons Installation and Administrator’s
Guide.

e A PING monitoring service allows you to monitor the presence of a targeted Host. This
service is not represented by a service node in the Management tree but is represented
in the Applications Pane (Monitoring Status Details).

5.1 Monitoring Hosts

The following categories and services can be used to monitor items independent from OS
(network access and protocols for instance). By default they appear under any declared host.

5.1.1 Internet Category

This category contains all the services for monitoring IP port (TCP, UDP, HTTP, FTP ...).

5.1.1.1 HTTP
The Internet.HTTP service monitors the HTTP access of the hosts on port 80 (by default) on
the ’/" URL (i.e. http://host:80/). The timeout value is 10 seconds.

e  Status is set to WARNING state for HTTP errors: 400, 401, 402, 403 or 404 such as
‘unauthorized access’.

e Status is set to CRITICAL state if the response time exceeds 10 seconds or for HTTP
errors 500, 501, 502 or 503, or if the connection with the server is impossible.

51.1.2 HTTP_NSMaster

The Internet.HTTP_NSMaster service monitors the presence and status of the BSM URL.

5.1.1.3 FTP

The Internet.FTP service checks the accessibility of FTP on its standard port (21).

e Status is set to WARNING state if the connection is successful, but incorrect response
messages are issued from the host.

e Status is set to CRITICAL state if the response time exceeds 10 seconds or if the
connection with the server is impossible.
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5.1.14 TCP_n

The Internet. TCP_n service monitors a TCP port access of the hosts.

e Status is set to CRITICAL state if the connection with the server is impossible.

5.1.1.5 UDP_n

The Internet.UDP_n service monitors a UDP port access of the hosts.

e Status is set to CRITICAL state if the connection with the server is impossible.

5.1.2 Reporting Category

This category contains all the services for monitoring reporting indicators associated to a

threshold.

5.1.2.1 Perf_indic

The reporting.Perf_indic service monitors defined reporting indicators.

Please refer to the Administrator’s Guide for details.
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5.2

5.2.1

52.1.1

Monitoring Linux or AIX Systems

The following categories and services can be used to monitor Linux or AIX systems. By
default they appear under any host, declared as a Linux or AIX system.

FileSystems Category

This category contains all the services for monitoring file systems.

All Service

The FileSystems.All service monitors the percentage of used space for each mounted
filesystem, except CD-ROM and floppy disks.

e Status is set to WARNING if there is at least one filesystem with more than 80% used
space.

e Status is set to CRITICAL if there is at least one filesystem with more than 90% used
space.

Status Information
If status is set to WARNING or CRITICAL, Status Information lists the filesystems concerned.

Examples:

DISKS OK: all disks less than 80% utilized

DISKS WARNING: /home more than 80% utilized

DISK CRITICAL: ( /7 ) more than 90% utilized - DISKS WARNING: ( /usr
/var ) more than 80% utilized

Correcting Status

e From the Applications Pane, click System (Detailed Information box) to get information
about host filesystem size.

e From the Applications Pane, click the Operations menu and select:
Operating System > FileSystems.
You now have access to the host and you can investigate and correct the problem.
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5.2.2

5.2.2.1

523

5.2.3.1
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LinuxServices Category (for Linux system)

This category contains all the services for checking the presence of a Linux daemon.

Syslogd Service

The Syslogd service checks that there is one and only one syslogd process running on the
system.

Note

Syslogd is a system utility daemon that provides support for system logging.

o Status is set to WARNING if the number of syslogd processes is different from 1.
e Status is only set to CRITICAL when a processing error occurs.

Status Information

Gives the number of processes running with the syslogd name.

Example:

OK - 1 processes running with command name syslogd

Correcting Status

e From the Applications Pane, click Processes (Detailed Information box) to get the list of
processes currently running on the system.

e From the Applications Pane, click the Operations menu and select:
Operating System > SSH/Telnet.
You now have access to the host and you can investigate and correct the problem.

AlXServices Category (for AIX system)

This category contains all the services for checking the presence of a AIX daemon.

Syslogd Service

The Syslogd service checks that there is one and only one syslogd process running on the
system.

Note

Syslogd is a system utility daemon that provides support for system logging.

e Status is set to WARNING if the number of syslogd processes is different from 1.

e Status is only set to CRITICAL when a processing error occurs.
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5.2.4.1

Status Information
Gives the number of processes running with the syslogd name.

Example:

OK - 1 processes running with command name syslogd

Correcting Status

e From the Applications Pane, click Processes (Detailed Information box) to get the list of
processes currently running on the system.

e From the Applications Pane, click the Operations menu and select:
Operating System > SSH/Telnet.
You now have access to the host and you can investigate and correct the problem.

Syslog Category

This category contains all the services for monitoring the content of the syslog files.

AuthentFailures Service (for Linux system)

The AuthentFailures service monitors the /var/log/messages file for the detection of
authentication failure messages. It searches for the lines containing:

authentication failure or FAILED LOGIN or Permission denied,

but not containing login.*authentication failure (because such a line traps the same
error than a FAILED LOGIN line, already detected).

Note

Only new lines (if any) are checked each time. If the file has been truncated or rotated
since the last check, the search is started from the beginning.

e Status is set to WARNING if there is at least one new matching line since the last
check.

e Status is only set to CRITICAL when a processing error occurs.

umportqnt

WARNING status can be very fugitive in the Console.

When a new matching line appears in the log file, status is only set to WARNING during
the interval between the check that detects the error and the next check (if no new error
appears). You are therefore advised to activate the nofification mechanism for this service,
and fo regularly consult service history.

Note

The notify_recovery field is set to because it is not applicable to this service.
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Status Information

If status is set to WARNING, Status Information gives the number of lines and the last line
matching the searched patterns.

Examples:

OK - No matches found
(3): Nov 26 15:31:32 horus login[4786]: FAILED LOGIN 3 FROM isis FOR
admin, Authentication failure

Note “(3):" indicates that 3 matching lines were found; the text that follows (Nov 26
15:31:32 horus...) is the last matching line detected.

Correcting Status

e From the Applications Pane, click System Logs (Detailed Information box) to access
the content of the syslog files for the system. Then click View for /var/log/messages to
consult log file details.

e From the Applications Pane, click the Operations menu and select:
Operating System > SSH/Telnet.
You have now access to the host and you can investigate and correct the problem.

5.2.4.2 Errors Service (for AIX system)

The Syslog.Errors service monitors the number of error report generated in the error log
over the last 30 minutes (based on the errpt command).

e Status is set to WARNING if there is at least one new matching line since the last
check.

e Status is only set to CRITICAL when a processing error occurs.

A Important:

WARNING status can be very fugitive in the Console.

When a new matching line appears in the log file, status is only set to WARNING during
the inferval between the check that detects the error and the next check (if no new error
appears). You are therefore advised to activate the nofification mechanism for this service,
and fo consult regularly service history.

Examples:

No new Error Reports since Tue Jan 29 15:02:11 CST 2008
1 New error reports generated since Tue Jan 29 15:02:11 CST 2008
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5.2.5.1

Correcting Status

e From the Applications Pane, click the Operations menu and select:
Operating System > SSH/Telnet.
You have now access to the host and you can investigate and correct the problem.

SystemLoad Category

This category contains all the services for monitoring system load.

CPU Service (for Linux system)

The CPU service monitors total CPU load over three periods of time:

e 1 min
e 5 min
e 15 min.

CPU load is computed using the load average given by the w command, or in the
/proc/loadavg file. Load average is the average number of processes in the system run
quevue, that is, the number of processes able to run:

(load average / number of CPUs) * 100.

Therefore, CPU load should be equal to 100% when the average of running processes per
CPU is 1 (all CPUs are busy).
e Status is set to WARNING if the average CPU load is higher than:
- 80% over the last 1 minute
— 70% over the last 5 minutes
- 60% over the last 15 minutes.
e Status is set to CRITICAL if the average CPU load is higher than:
—  90% over the last 1 minute
- 80% over the last 5 minutes

—  70% over the last 15 minutes.

Status Information

Displays the percentage of average CPU load for respectively the last 1 minute, the last 5
minutes and the last 15 minutes.

Examples:
CPU Utilization: 0% (1Imn), 1% (5mn), 0% (15mn)

CPU Utilization: 86% (1mn), 51% (6mn), 33% (15mn) WARNING
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Correcting Status

e From the Applications Pane, click the Inventory menu and select:
Operating system > Processes to get process CPU consumption.

e From the Applications Pane, click the Operations menu and select:
Operating System > Processes.

You have now access to the host and you can investigate and correct the problem.

CPU Service (for AlX system)

This CPU service monitors the cpu load of an AlX system or an AIX partition.

The result depends on the partition type: shared (Uncapped or Capped) or dedicated.
e Status is set to WARNING if the average CPU load is higher than 80%.
e Status is set to CRITICAL if the average CPU load is higher than 90%.

Examples:

CPU OK - CPU load is O (idle:100.0% wait:0.0%) - type=Dedicated partition
CPU OK: Phys CPU load is 0.01 1% of 1 CPU (idle:99.0% wait:0%) - max_vp=2
type=Shared Uncapped partition

Correcting Status

e From the Applications Pane, click on the Inventory menu and select:
Operating System > Processes to get process CPU consumption.

e From the Applications Pane, click the Operations menu and select:
Operating System > Processes.

You have now access to the host and you can investigate and correct the problem.

Memory Service (for Linux system)

The Memory service monitors the percentage of used memory (physical + swap) for the
system.

o Status is set to WARNING if used memory is higher than 70%.
e Status is set to CRITICAL if used memory is higher than 90%.
Status Information

Displays the total (physical + swap) memory size in Mbytes, the total used memory in
Mbytes and percent, the total free memory in Mbytes and the physical memory size in
Mbytes.

Examples:

Status: OK - (total: 2996Mb) (used: 863Mb, 29%) (free: 2132Mb)
(physical: 1004Mb)
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Status: WARNING - (total: 1097Mb) (used: 878Mb, 80%) (free: 219Mb)
(physical: 501Mb)

Correcting Status

e From the Applications Pane, click System (Detailed Information box) to get memory

consumption details.

Click Processes to get information on memory consumption for each process running

on the system.

e From the Tree Pane, display the host pop-up menu and select:
Remote Operation > Actions, or Remote Operations > Telnet

You have now access to the host and you can investigate and correct the problem.

Processes Service (for Linux system)

The Processes service monitors the number of processes running on the system.
e Status is set to WARNING if the number of processes is higher than 150.
e Status is set to CRITICAL if the number of processes is higher than 200.
Status Information

Displays the number of processes running on the system.

Examples:

OK - 101 processes running
WARNING - 162 processes running

Correcting Status

e From the Applications Pane, click Processes (Detailed Information box) to get the list of

the processes.

e From the Applications Pane, click the Operations menu and select:
Operating System > Processes
You have now access to the host and you can investigate and correct the problem.

Users Service (for Linux system)

The Users service monitors the number of users currently logged in the system.
e Status is set to WARNING if the number of connected users is higher than 15.
e Status is set to CRITICAL if the number of connected users is higher than 20.

Status Information

Displays the number of users logged to the system.
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Examples:

USERS OK - 2 users currently logged in
USERS WARNING - 16 users currently logged in

Correcting Status

e From the Applications Pane, click Processes (Detailed Information box) to get
information on users running processes.

e From the Tree Pane, display the host pop-up menu and select:
Remote Operation > Actions or Remote Operation > Telnet
You have now access to the host and you can investigate and correct the problem.

5.2.5.6 PagingSpace Service (for AIX system)

The PagingSpace service monitors the current system paging space in relation with paging
space in and paging space out parameters.

e Status is set to WARNING if the paging space used is higher than 80%.
e Status is set to CRITICAL if the paging space used is higher than 90%.

Example:

OK - Used paging space 0.72 % : paging-ins 0.00 pg/s paging-outs : 0.00 pg/s

Correcting Status

e From the Applications Pane, click the Operations menu and select:
Operating System > SSH/Telnet.

You have now access to the host and you can investigate and correct the problem.

5.2.5.7 Swap Service (for AIX system)

The Swap service monitors the current system swap space .
e Status is set to WARNING if the swap space used is higher than 50%.
e Status is set to CRITICAL if the swap space used is higher than 80%.

Examples:

Swap ok - Swap used: 0% (5 out of 512)

Correcting Status

e From the Applications Pane, click the Operations menu and select:
Operating System > SSH/Telnet.

You have now access to the host and you can investigate and correct the problem.
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5.3

53.1

5.3.1.1

Monitoring Windows Systems

The following categories and services can be used to monitor Windows systems. By default
they appear under any host, declared as a Windows system.

Note

The Windows monitoring agent part is based on two Windows services:

e Bull System Manager Management agent
lts main function is giving OS and HW information, but it provides the LogicalDisk.All
monitoring service too.

e Bull System Manager Monitoring agent
It provides all Windows monitored services, except LogicalDisk.All.

Eventlog Category

This category contains all the services for monitoring the Windows Event Log.

Application Service
The Eventlog.Application service monitors the number of Error, Warning and Information
events generated in the Application Event log for the last 300 minutes.

e  Status is set to WARNING if there are more than 10 Information events or at least 1
Warning event.

e  Status is set to CRITICAL if there is at least 1 Error event.
Status Information

If status is set to WARNING or CRITICAL, gives the number of events responsible. This
message is also a link to an html file containing the following detailed information:

Event Type Error or Warning or Information.

Last Time Last time an event with the same type, source and id occured.
Count Number of events with the same type, source and id.

Source Event source.

Id Event id.

Description Event message.

Examples:

OK: no new events for the last 30 mn
WARNING: 1 new events for the last 30 mn!

The text “1 new events for the last 30 mn!” is a link that displays detailed
information:
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Correcting Status

e From the Applications Pane, click Events (Detailed Information box) for more
information.

e From the Applications Pane, click the Operations menu and select:
Operating System > VNC Viewer or Remote Desktop.
You have now access to the host and you can correct the problem.

Security Service
The Eventlog.Security service monitors the number of Audit Success, Audit Failures, Error
and Warning events generated in the Security event log over the last 30 minutes.

e  Status is set to WARNING if there are more than 10 Audit Success events or at least 1
Warning event.

e  Status is set to CRITICAL if there is at least 1 Audit Failure or Error event.

Status Information

If status is set to WARNING or CRITICAL, gives the total number of events responsible. This
message is also a link to an html file containing the following detailed information:

Event Type Error, Warning, Information, Audit Success or Audit Failure.
Last Time Last time an event with the same type, source and id occurred.
Count Number of events with the same type, source and id.

Source Event source.

Id Event id.

Description Event message.

Examples:

OK: no new events for the last 30 mn
WARNING: 4 new events for the last 30 mn!

Correcting Status

e From the Applications Pane, click Events (Detailed Information box) for more
information.

e From the Applications Pane, click the Operations menu and select:
Operating System > VNC Viewer or Remote Desktop.
You have now access to the host and you can correct the problem.
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53.2

5.3.2.1

System Service
The Eventlog.System service monitors the number of Error, Warning and Information events
generated in the System event log over the last 300 minutes.

e  Status is set to WARNING if there are more than 10 Information events or at least 1
Warning event.

e  Status is set to CRITICAL if there is at least 1 Error event.
Status Information

If status is set to WARNING or CRITICAL, gives the total number of events responsible. This
message is also a link to an html file containing the following detailed information:

Event Type Error, Warning or Information.

Last Time Last time an event with the same type, source and id occurs.
Count Number of events with the same type, source and id.
Source Event source.

Id Event id.

Description Event message.

Examples:

OK: no new events for the last 30 mn
CRITICAL: 8 new events for the last 30 mn!

Correcting Status

e From the Applications Pane, click Events (Detailed Information box) for more
information.

e From the Applications Pane, click the Operations menu and select:
Operating System > VNC Viewer or Remote Desktop.
You have now access to the host and you can investigate and correct the problem.

LogicalDisks Category

This category contains all the services for monitoring the logical disks.

All Service

The All service monitors the percent of used space for each local disk. The local disks list is
dynamically established at each check.
e Status is set to WARNING if one of the disks has more than 80% used space.

e Status is set to CRITICAL if one of the disks has more than 90% used space.
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Status Information
Gives the list of the local disks checked.

Examples:

DISKS OK: all disks (C:, E:, F:) less than 80% utilized
DISK WARNING: (G:) more than 90% utilized - DISKS CRITICAL: (C:) more
than 80% utilized

Correcting Status

e From the Applications Pane, click Logical Disks (Detailed Information box) to get all
information about the size of the host disks. Then click Storage to get information on
the physical storage devices for the host.

e From the Applications Pane, click the Operations menu and select:
Operating System > VNC Viewer or Remote Desktop.
You have now access to the host and you can investigate and correct the problem.

SystemLoad Category

This category contains all the services for monitoring the load of the system.

CPU Service

The CPU service monitors the total CPU load over two periods of time: Tmin and 10 min
e Status is set to WARNING if the average CPU load is higher than:

- 80% over the last 1 minute

- 60% over the last 10 minutes.
e Status is set to CRITICAL if the average CPU load is higher than:

- 90% over the last 1 minute

—  80% over the last 10 minutes.
Status Information
Displays the percentage of average CPU load for respectively the last minute and the last
10 minutes. If status is WARNING or CRITICAL, it displays the most consuming process,

and its percentage of CPU consumption, at check time.

Examples:

CPU Load OK (Imn: 8%) (10mn: 5%)
CPU Load HIGH (Imn: 92%) (10mn: 56%) - Process cputest.exe using 100%
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Correcting Status

e From the Applications Pane, click CPU (Detailed Information box) to get CPU
consumption per processor. Then click Processes to get CPU time spent per process.

e  From the Tree Pane, display the host pop-up menu and select:
Remote Operation > VNC Viewer or Remote Operation > Telnet.
You have now access to the host and you can investigate and correct the problem.

MemoryUsage Service

The MemoryUsage service monitors the total memory (physical + paged) used by the
system. It is equivalent to the Commit Charge displayed in the Windows Task Manager.

e Status is set to WARNING if the memory used is higher than 70%.
e Status is set to CRITICAL if the memory used is higher than 90%.
Status Information

Displays the total (physical + paged) memory size in Mbytes, the total memory used in
Mbytes and percent, the total memory free in Mbytes and the physical memory size in

Mbytes.

Examples:

Memory Usage OK - (total: 1480Mb) (used: 193Mb, 13%) (free: 1287Mb)
(physical: 511Mb)

Memory Usage WARNING - (total: 2462Mb) (used: 1773Mb, 72%) (free:
689Mb) (physical: 1023Mb)

Correcting Status

e From the Applications Pane, click Memory (Detailed Information box) to get detailed
memory consumption.
Then click Processes to get memory consumption spent per process.
Then click General (Host Information box) to get information about the physical
memory configuration and layout.

e From the Applications Pane, click the Operations menu and select:
Operating System > VNC Viewer or Remote Desktop.
You have now access to the host and you can investigate and correct the problem.
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5.3.4 WindowsServices Category

5.3.4.1 Eventlog Service

The WindowsServices.Eventlog service monitors the state of the services involved in event
logging functions:

Service Display Description
Key Name
Eventlog | Event Log Log event messages issued by programs and Windows.

Event Log Reports contain information that can be useful in
diagnosing problems. Reports are viewed in Event Viewer

e Status is set to WARNING at least one of these services is paused and the others are
running.

e  Status is set to CRITICAL if at least one of these services does not exist or is not
running.

Status Information
Displays service name and status.

Examples:

OK: “EventLog”’
NotActive: “EventlLog’

Correcting Status

e From the Applications Pane, click Memory (Detailed Information box) to get detailed
information about services.

e From the Applications Pane, click the Operations menu and select:
Operating System > VNC Viewer or Remote Desktop.
You have now access to the host and you can investigate and correct the problem.
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5.4.1

5.4.1.1

5.4.1.2

Hardware Monitoring

Hardware Category for Express 5800

PowerStatus Service

The PowerStatus service reflects the power status of an Express 5800 server, as returned by

the RMC management card.

e Status is set to CRITICAL if RMC has assigned a power status off.

e Status is set to UNKNOWN if RMC is not accessible or if RMC has not been able to
compute power status.

Correcting Status

e From the Tree Pane, display the host pop-up menu and select RMC to launch the CMM
tool and investigate and correct the problem.

Note  For more information about RMC, please refer to the documentation delivered with your
server.
Alerts Service

The Alerts Service is used to collect the hardware SNMP traps emitted by the manager.

This service uses the bmclanpet mib, integrated in the Bull System Manager application.
SNMP trap reception must be enabled.

The Hardware Management card must be correctly configured to send traps to the Bull
System Manager_SERVER host.

The status of this service depends on trap severity:

e Status is set to OK if frap severity is NORMAL.

e Status is set to WARNING if trap severity is INFORMATION or WARNING.
e Status is set to CRITICAL if trap severity is MAJOR or CRITICAL.

As Administrator, you can display and edit trap severity through the Configuration
application. Please refer to the Administrator’s Guide for details.
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Hardware Category for NovaScale 3000 Series

PowerStatus Service

The PowerStatus service reflects the power status of a NovaScale server, as returned by the
management card.

e Status is set to CRITICAL if the cardName has assigned a power status off.

e  Status is set to UNKNOWN if the cardName is not accessible or if the cardName has
not been able to compute power status.

Alerts Service

The Alerts Service is used to collect the hardware SNMP traps emitted by the manager.

This service uses the bmclanpet and SMSmp mibs integrated in the Bull System Manager
application. SNMP trap reception must be enabled.

The Hardware Management BMC must be correctly configured to send traps to the Bull
System Manager_SERVER host.

The status of this service depends on trap severity:

e Status is set to OK if trap severity is NORMAL.

e Status is set to WARNING if trap severity is INFORMATION or WARNING.
e Status is set to CRITICAL if trap severity is MAJOR or CRITICAL.

As Administrator, you can display and edit trap severity through the Configuration
application. Please refer to the Administrator’s Guide for details.

Hardware Category for NovaScale T800 & R400 Series

PowerStatus Service

The PowerStatus service reflects the power status of a NovaScale server, as returned by the
management card.

e Status is set to CRITICAL if the cardName has assigned a power status off.

e  Status is set to UNKNOWN if the cardName is not accessible or if the cardName has
not been able to compute power status.

Alerts Service

The Alerts Service is used to collect the hardware SNMP traps emitted by the manager.

To enable this service, the bmclanpet mib must be integrated in the Bull System Manager
application. SNMP trap reception must be enabled.

At installation time, the mib is integrated and SNMP trap reception is enabled.
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The Hardware Management BMC must be correctly configured to send traps to the Bull
System Manager_SERVER host.

The status of this service depends on trap severity:

Status is set to OK if trap severity is NORMAL.
Status is set to WARNING if trap severity is INFORMATION or WARNING.
Status is set o CRITICAL if trap severity is MAJOR or CRITICAL.

As Administrator, you can display and edit trap severity through the Configuration
application. Please refer to the Administrator’s Guide for details.

Hardware Category for NovaScale Blade Series

Health Service

The Health service monitors hardware status, as returned by the CMM software tool.

To enable this service, a CMM manager must be declared for the host and the hardware
identifier (used to identify the host in the NovaScale Blade Chassis) must be provided
during Bull System Manager configuration. Please refer to the Administrator’s Guide for
details.

Status is set to WARNING if CMM has assigned a WARNING status to the host.
Status is set to CRITICAL if CMM has assigned a CRITICAL status to the host.

Status is set to UNKNOWN if CMM is not accessible or if the host has not been
successfully mapped in the chassis (due for example to an incorrect hardware
identifier).

Status Information

Status information is set by CMM and represents the host hardware status.

Examples:
Current status: OK
Status Information No critical or warning events

The hardware state of the host is OK.

Current status: CRITICAL
Status information: DASD Removed.

The hardware state of the host is CRITICAL.

Current status: unknown
Status information: Unable to get SNMP response [No response from
remote host ”192.168.207.46~
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The hardware state cannot be retrieved from the CMM manager due to connection
timeout. This issue can result from a bad declaration of the SNMP Manager in the
CMM configuration.

Correcting Status

From the Tree Pane, display the host pop-up menu and select HW Manager GUI to launch
the CMM tool and investigate and correct the problem.

Note

For more information about CMM, please refer to the documentation delivered your server.

Hardware Category for NovaScale 4000 Series

Alerts Service
The Alerts Service is used to collect the hardware SNMP traps emitted by the host.
To enable this service, the basebrd5 mib must be integrated in the Bull System Manager
application and SNMP trap reception must be enabled.
At installation time, the mib is integrated and SNMP trap reception is enabled.
Traps are previously filtered and only the traps emitted by the Hardware Management card
are used fo animate this service. The Hardware Management card must be properly
configured with the Intel SMU tool to send traps to the Bull System Manager_server host.
The status of this service depends on trap severity:
e Status is set to OK if trap severity is NORMAL.
e Status is set to WARNING if trap severity is INFORMATION or WARNING.
e Status is set to CRITICAL if trap severity is MAJOR or CRITICAL.
As Administrator, you can display and edit trap severity through the Configuration
application. Please refer to the Administrator’s Guide for details.
Status Information
Trap description, as found in the trap mib, is used as status information
Example:
Trap systemHealthCriticalEvent — Server Health Critical: The overall
health of the server is critical
Correcting Status
From the Tree Pane, display the host pop-up menu and select HW Manager GUI to launch
the ISM tool and investigate and correct the problem.
Note  For more information about ISM, please refer to the documentation delivered your server.
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5.4.6

5.4.6.1

Health Service

The Health service monitors hardware status, as returned by the Intel System Management
(ISM) software tool.

To enable this service, a manager must be declared for the host (see the Administrator’s
Guide for details about how, as Administrator, you can declare a manager) and ISM must
be installed and running on that manager.

Health is an ISM indicator that reflects the global state of hardware. The hardware
components taken into account in Health can be configured in ISM.

e Status is set to WARNING if the status of one of the hardware components described
as a contributor to Health is WARNING.

e Status is set to CRITICAL if the status of one of the hardware components described as
a contributor to Health is CRITICAL.
Correcting Status

From the Tree Pane, display the host pop-up menu and select:
HW Manager GUI to launch the ISM tool and investigate and correct the problem.

Hardware Category for NovaScale 5000 & 6000 Series

Health Service
The Health service monitors hardware status, as returned by the PAM software tool, for the
host (or PAM domain).
To enable this service, a manager must be declared for the host (see the Administrator’s
Guide for details about how, as Administrator, you can declare a manager) and a PAP
server must be installed and running on that manager.
e Status is set to WARNING if PAM has assigned a WARNING status to the domain.
e Status is set to CRITICAL if PAM has assigned a CRITICAL status to the domain.
e Status is set to UNKNOWN if PAM is not accessible or if PAM has not successfully
computed domain status.
Status Information
Status information is set by PAM and represents host hardware status.
Example:
For the Domain FAMEOOO_OIDO of the CentralSubSystem FAMEOOO, the functional
status is NORMAL (The domain state is ”BIOS READY - STARTING EFI)
Correcting Status
From the Tree Pane, display the host pop-up menu and select:
PAM to launch the PAM tool and investigate and correct the problem.
Note For more information about PAM, see the documentation delivered with your server.
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Other Monitoring

PAM Category

GlobalStatus Service
The GlobalStatus service reflects global functional status, as returned by the PAM manager.
This comprises the hardware status of the whole configuration managed by this instance of
PAM, as well as the status of the PAM manager itself.
This service only exists on a host declared as a NovaScale 5000 / 6000 manager (see the
Administrator’s Guide for details about how, as Administrator, you can declare a
manager).
e Status is set to WARNING if PAM has assigned a WARNING status to the
configuration.
e Status is set to CRITICAL if PAM has assigned a CRITICAL status to the configuration.
e Status is set to UNKNOWN if PAM is not accessible or if PAM has not successfully
computed global status.
Status Information
Status information is set by PAM and represents the global functional state for the managed
hosts and for the PAM manager tool.
Examples:
The PAM manager global status is WARNING
Correcting Status
From the Tree Pane, display the host pop-up menu and select PAM to launch the PAM tool
and investigate and correct the problem.
Note For more information about PAM, see to the documentation delivered with your server.
Alerts Service
The Alerts Service is used to collect hardware SNMP traps emitted by the manager.
To enable this service, the PAMEventtrap mib must be integrated in the Bull System
Manager application and SNMP trap reception must be enabled.
At installation time, the mib is integrated and SNMP trap reception is enabled.
The Hardware Management card must have been correctly configured to send traps fo the
Bull System Manager_SERVER host.
The status of this service depends on trap severity:
e Status is set to OK if trap severity is NORMAL.
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e Status is set to WARNING if trap severity is INFORMATION or WARNING.
e Status is set to CRITICAL if trap severity is MAJOR or CRITICAL.

As Administrator, you can display and edit trap severity through the Configuration
application. Please refer to the Administrator’s Guide for details.

55.2 CMM Category

5.5.2.1 ChassisStatus Service

The ChassisStatus service reflects the functional status of the NovaScale Blade Chassis, as
returned by the CMM manager. This state comprises the hardware status of the whole
configuration managed by this CMM, as well as the status of the CMM manager itself.

This service exists only on a host that is declared as a CMM manager (see the
Administrator’s Guide for details about how, as Administrator, you can declare a
manager).

e Status is set to WARNING if CMM has assigned a WARNING status to the host.
e Status is set to CRITICAL if CMM has assigned a CRITICAL status to the host.

e  Status is set to UNKNOWN if CMM is not accessible or if CMM has not been able to
compute global status.

Correcting Status

From the Tree Pane, display the host pop-up menu and select CMM to launch the CMM
tool and investigate and correct the problem.

Note  For more information about CMM, see to the documentation delivered with your server.

5522 Alerts Service

The Alerts Service is used to collect the hardware SNMP traps emitted by the manager. To
enable this service, the mmalert mib must be integrated in the Bull System Manager
application and SNMP trap reception must be enabled.

At installation time, the mib is integrated and SNMP trap reception is enabled.

The Hardware Management card must be correctly configured to send traps to the Bull
System Manager_SERVER host.

The status of this service depends on trap severity:

e Status is set to OK if trap severity is NORMAL.

e Status is set to WARNING if trap severity is INFORMATION or WARNING.

e Status is set to CRITICAL if trap severity is MAJOR or CRITICAL.

As Administrator, you can display and edit trap severity through the Configuration
application. Please refer to the Administrator’s Guide for details.
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RMC Category

PowerStatus Service
The PowerStatus service reflects the power status of an Express 5800, as returned by the
RMC management card.
This service exists only on a host that is declared as a RMC manager (see the
Administrator’s Guide for details about how, as Administrator, you can declare a
manager).
e Status is set to CRITICAL if RMC has assigned a power status off.
e Status is set to UNKNOWN if RMC is not accessible or if RMC has not been able to
compute power status.

Correcting Status
From the Tree Pane, display the host pop-up menu and select RMC to launch the CMM tool
and investigate and correct the problem.

Note  For more information about RMC, see to the documentation delivered your server.
Alerts Service

The Alerts Service is used to collect the hardware SNMP traps emitted by the manager.

To enable this service, the bmclanpet mib must be integrated in the Bull System Manager
application and SNMP trap reception must be enabled.

At installation time, the mib is integrated and SNMP trap reception is enabled.

The Hardware Management card must be correctly configured to send traps to the Bull
System Manager_SERVER host.

The status of this service depends on trap severity:

o Status is set to OK if trap severity is NORMAL.

e Status is set to WARNING if trap severity is INFORMATION or WARNING.
e Status is set to CRITICAL if trap severity is MAJOR or CRITICAL.

As Administrator, you can display and edit trap severity through the Configuration
application. Please refer to the Administrator’s Guide for details.
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5.6.1

5.6.1.1

5.6.2

5.6.2.1

Storage Monitoring

Storage Category

SanitStatus Service

The SanitStatus service monitors the state of the storage, returned by the S@N.IT!
application, for any host managed in the SAN.

e To enable this service, a SANIT manager must be declared for the host.

e Status is set to OK if S@N.IT! has assigned a NORMAL status to the host.

e Status is set to CRITICAL if S@N.IT! has assigned a FAULTY status to the host.

e Status is set to UNKNOWN if S@NL.IT! has assigned an UNKNOWN or NOT
MONITORED status to the host OR if the storage identifier provided during the Bull
System Manager configuration is not valid. Please refer to the Administrator’s Guide
for details.

Correcting Status

From the Tree Pane, display the host pop-up menu and select S@NL.IT! to launch the client
part of the application (Web or local mode) and investigate and correct the problem.

SANIT Category

Alerts Service
The Alerts Service is used to collect the SNMP traps emitted by the S@NL.IT! application.

To enable this service, the femgmt3 mib must be integrated in the Bull System Manager
application and SNMP trap reception must be enabled.

At installation time, the mib is integrated and SNMP trap reception is enabled.

The S@N.IT! application must be correctly configured to send traps to the Bull System
Manager_SERVER host.

The status of this service depends on trap severity:

e Status is set to OK if trap severity is NORMAL.

e Status is set to WARNING if trap severity is INFORMATION or WARNING.

e Status is set to CRITICAL if trap severity is MAJOR or CRITICAL.

As Administrator, you can display and edit trap severity through the Configuration
application. Please refer to the Administrator’s Guide for details.
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5.6.3 MegaRAID Category

5.6.3.1 Status Service

The Status service monitors the state of the storage, returned by the MegaRAID SNMP
agent.

e To enable this service, MegaRAID category and Status service must be configured for
the host.

e Status is set to OK if agent has assigned a NORMAL status to the host.
e Status is set to CRITICAL if agent has assigned a FAULTY status to the host.

e Status is set to UNKNOWN if agent has assigned an UNKNOWN or NOT
MONITORED status to the host. Please refer to the Administrator’s Guide for details.

5.6.3.2 Alerts Service

The Alerts Service is used to collect the SNMP traps emitted by the MegaRAID SNMP
agent.

To enable this service, the megaraid mib must be integrated in the Bull System Manager
application and SNMP trap reception must be enabled.

At installation time, the mib is integrated and SNMP trap reception is enabled.

The MegaRAID SNMP agent must be correctly configured to send traps to the Bull System
Manager_SERVER host.

The status of this service depends on trap severity:

e Status is set to OK if trap severity is NORMAL.

e Status is set to WARNING if trap severity is INFORMATION or WARNING.

o Status is set to CRITICAL if trap severity is MAJOR or CRITICAL.

As Administrator, you can display and edit trap severity through the Configuration
application. Please refer to the Administrator’s Guide for details.
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